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The topics in this section provide some basic information about pCon.basket, whatit is for and what you can
do with it.

pCon.basket was developed through collaborations between EasternGraphics and leading manufacturers and
dealerships in the furniture industry. The goal was to develop a compatible and easily integrated tool
suitable for all companies operating in the industry. Today the scope and use of pCon.basket reaches well
beyond the boundaries of the furniture industry.

The data used by pCon.basket is based on OFML (Office Furniture Modeling Language) an open standard of the
German furniture manufacturer’s association (BSO). Nowadays is an accepted standard in several countries
and used by the European leading manufacturers.

The traditional method of creating offers through the use of MS Excel is outdated due to its inefficiency and
great limitations. This type of application presents a lot of limitations, like

® manuallyinsertthe data in to the spreadsheet including images if desired

®  manually define calculation formulas and double check them

® impossibility to do reverse discount calculations

® impossibility to do margin calculations

e ifgroups areinvolved, extra effortin calculating subtotals and formatting spreadsheet
® time consuming to make offer updates, which is a usual need

®* impossibility of extracting information into other applications

pCon.basket was build specifically to create offers - it facilitates the configuration and selection of articles,
the structuring of articles in groups, the configuration and calculation of articles and the creation of a
flexible but easy to create offer. pCon.basket can be integrated with 3rd party applications like enterprise
resource planning systems (ERP), customer relationship management systems (CRM), ad hoc databases and
others. This integration assures a very efficient sales value chain.

pCon.basket can be used alone or in conjunction with pCon.planner or pCon.xcad for projects where you need
to create a drawing or need to specify complex products with the assistance of advanced product rules.

Currently we have 110+ office furniture manufactures, 40+ manufactures in other industries and thousands of
dealers all over the world.
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pCon.basket is a commercial software which needs to be enabled through a license. The following kinds of
licenses are supported:

e Standard, host-dependent license

® Dongle-based single workstation license
®* Dongle-based network license

® Demo license, usually time-limited

To activate the license key you received from EasternGraphics please use the EGR-LicenseClient. You can find
itin the apps of the Windows® start menu. With the EGR-LicenseClient you can activate not only pCon.basket
but also all other applications of EasternGraphics. Start this tool and insert your license key. An enabler code
is requested automatically in the background. You only need a connection to the internet. If you activate your
license for the first time, the enabler code will be immediately sent back to your EGR-LicenseClient. If you wish
a spare activation, please contact at first your local EasternGraphics team.

If you get a license file (*.lic) you have to copy it into the directory etc/licenses of the pCon.basket
installation. If you are using license templates (*.lit) not available in the standard pCon.basket distribution,
pleaseinstall themin etc/licenses/templates.

In case of dongle-based single workstation licenses pleaseinstall the dongle driver.

Please contact your local EasternGraphics team for further information.
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The user interfaceis divided into four main sections.
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pCon.basket interface
Catalog

The catalogis available in the lower part of the screen. Articles are selected here. Articles are catalogued in a
tree structure. Each series can have several subcategories and its structure is based on the technical and
commercial characteristics of the articles that it is made up of. Articles can be selected graphically or by
directly entering the article code. The catalog also offers the option of searching for an article using a partial

code.

Article tree

The article treeis located in the left part of the screen. It can be structured with folders, each representing a
group containing subgroups or articles. Groups have advanced calculations and print options. Detailed
article and group information can be found on the workspace area.

Article / group print settings

The article/group print setting is located below the article tree. Its contents are only visible when an article or
group is selected. It enables you to define several printing settings for the selected article tree elements, for
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example where to place page breaks or if to display a group’s total.

Workspace

Contains a series of interchangeable tabs located at the bottom which allow you to manipulate the articles
selected in the workspace. There are 5 sub areas: article list, article configuration, price management, text
information management and catalog information.
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Every offer you create is saved in a separate project file. The standard pCon.basket file format will be saved
with the .obk extension. This topic shows how to create and save a project, what project settings can be made
and gives hints for naming conventions and storage of the projects.

To create a new offer, you can choose one of the following methods:
e Select File > New

e Key combination CTRL+ N

e Selectthe button on the upper tool bar

If a new offer is created, the open one will be closed. This occurs automatically if the last change was saved,
otherwise the application will ask if the offer should be saved. An affirmative answer will allow you to save
the offer under its already given name and open a new offer, if you select ‘No’ all changes will be lost.

To open more than one offer at the same time, open another pCon.basket application. Having two or more
pCon.basket applications running enables you to copy positions from one application to the other.

You can open an offer in the following ways:
e Select File 2 Open...

e Key combination CTRL+ 0O

e Selectthe & button on the upper tool bar

When you decide to open an existing offer, a dialogue window will appear where you can choose the file. If
you haven't save the changes to the current offer when you open a new one, the program will ask if you want
to save the changes and will then open the requested offer.

You can open two types of files:

® .obk,is the native pCon.basket format. pCon.xcad is able to export files in this format.

e fml,is the native pCon.planner format. See also for an alternative method of importing
articles from pCon.planner.

NOTE: When you open an .fml file with pCon.basket you have to execute the command Extras a Convert
Planning Articles. This procedure allows you to convert the .fml file to a fully functional pCon.basket offer.

© 2016 EasternGraphics GmbH PD - pCon.basket - User Guide 9



EasternGraphics

You can save an offer in the following ways:
e Select File > Save

e Keycombination CTRL+S

e Selectthe H button on the upper tool bar

If the offer already has a name, it will automatically be saved under this name. If the offer still has not been
named, a dialogue window will appear where you can specify the file name and select the destination folder.

You can save an offer under a new name through:

e Select File > Save As...

3.3.1 Naming convention

It's important that your dealership defines a naming convention standard for all offers. This naming should
be used by all sales reps. It will allow you to quickly identify the offers and it’s especially important if you
work in a bigger dealership with several sales reps.

We propose the following model tested by many dealers:
SalesRepCode_OfferNumber_Date_ClientName_BriefDescription.obk

® SalesRepCode is a two digit code univocally representing a sales rep. For example ‘FS’ for ‘Frank
Sinatra’

®  OfferNumberis a sequential number maintained by each sales rep
® Dateis the date of the offer creation in format ddmmyyyy
® C(ClientName is the name of the client

®  BriefDescription is a short comment on the project to quickly identify several projects for the same
customer, otherwise the only other two differentiators would normally be the offer number and the
date, which none of them is descriptive.

Let’s look this example “FS_301_281107_MGMCasino_MeetingRoom3rdFloor.obk”. This project was created
by Frank Sinatra with offer number 301 on 28/11/07 for a Meeting Room on the 3rd floor of the MGM Casino.
If you have different versions of the same offer it's an important to create a new file name by updating the
date when the new version was created. This assures you keep an historical track of the changes.

Another advantage of this naming convention is the fact that you can use the normal Windows search to filter
your offers. For example, if you want to see only offers created by Frank Sinatra you could do search with the
string ‘FS*.obk’. If you want to search all offers done for MGM Casino you can search with the string
“*MGMCasino*.obk’.

Alittle structure in naming offers provides your dealership important benefits in the long run.
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3.3.2 Offer storage

Nowadays most sales reps have their own laptops, which they will use to create offers. It's important to
consider a method to ensure that the offers created are centrally stored and that a backup mechanism is in
place. If a laptop is stolen or damaged you risk losing important historical and ongoing work information
that can be impossible or very expensive to recover.

There are two main ways to back up your laptops, manually or automatically. The manual process consists of
having the laptop user manually saving in a centralized server all offers with a regular frequency. The
automatic process assures synchronization between a specific folder in the laptop and the server each time
the computer is connected your company’s network.

Contact the member or organization responsible for your network administration to define the best process
for your dealership.

Defining a project’s properties is an important task you should do at the start of each new proposal. Many of
the properties you’ll define here are used by pCon.basket in different occasions, like during the report

creation. You can call the window by selecting Edit —* Project Settings.

Address and Project

The Address and Project tab can be configured with general offer information, many of these fields will be
later used in the automatic offer creation report. The three fields in the ‘information’ section will be
automatically filled out by pCon.basket after the first time the user saves a file.

-

= Project Settings 7=

Address and Project Calculation I Texts | Cumencies

Address Project
Customer Number Project Number
Compary Project Name
Organization Project Description
Strest

Postal Code / City
Postal Code / Post-Office Box

Country Germary E
Language English [=] Extemal Reference Number
Country-Code Extemal Reference Text
City-Code Information
Person In Charge Path:
Phone/Fax Create Date:
E-mail Address Last Modffied: |25
0K ] ’ Cancel ] ’ Accept

Project properties Address and Project
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Calculation

The Calculation tab allows you to specify financial information that will be applied to all articles inserted in
the offer. You can define the , the country for which you want to prepare the offer, a project’s
currency, the rounding of prices and the VAT. Please see for more information regarding
discounts and upcharges. For details on the rounding settings see chapter

“?1, Project Settings @

Address and Project | Calculation: | Texs | Cumencies

Pricing

Price Date: [21.04.2016

Cumency and Tax

Country: - no specific country - Iz‘

Subdivison: | - no specific region -

Variant: - no specific varant -

Curency: | Euro (EUR) [=]

Tax Rates: | Value Added Tax Standard rate 00| %

Rounding
Mode: no rounding Iz‘
Interval: 0.01 EUR

QK ] ’ Cancel Accept

Project Properties Calculation

NOTE: The selection of a country specific tax scheme is only available with a license for the
Texts

The Texts tab allows you to enter additional text. First, the language is chosen and then the text is typed. The
additional text appears in the offer header before the article list.
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‘?‘ Project Settings @
Address and Project | Caleulation | Teats | Cumencies |
Mo cument view.
Text name Language Description
Addttional test Geman Iz‘

Ok || Cancel |[ Accept

Project Properties Texts

Currencies

The Currencies tab allows you to change the exchange rates used for this project (local exchange rates). If you
want to update the exchanges rates to the exchanges rates set in the pCon.basket settings (global exchange
rates) you have to press the button ‘Reset’.

-

=, Project Settings [® =]
Address and Project | Calculation I Texts | Cumencies |
Reference Cumency | EUR - Euro Iz‘
Cumrency From ELR To EUR -
AED - United Arab Emirates Dirham 4,85300 0.205804
ARS - Argertine Peso 757600 0131996 || =
AUD - Australian Dollar 148700 0672495
BHD - Bahraini Dinar 0.512000 185312
BND - Brunei Dollar 171200 0584112
BRL - Brazilian Real 316200 0316256
CAD - Canadian Dollar 1,35400 0.717360
CHF - Swiss Franc 1.23000 0.813008
CLP - Chilean Peso 675.680 0.00147999
CNY - Chinese Yuan 816300 0.122504
COP - Colombian Peso 257207 0,000388752
CZK - Czech Republic Koruna 25,8030 0,0387552
DKK - Danish Krone 746000 0,134048
DZD - Algerian Dinar 108,285 0,00923489 | ~
[ Pt ]
[ ok || cancel |[ Accept |

Project Properties Currencies
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Articles can beinserted in an offer following two methods
e Dbyimporting articles from pCon.planner/pCon.xcad
®* byinsertingindividual articles directly from pCon.basket’s catalog.

The normal process will be to import articles from the other two pCon modules since there you can use the
power of advance product configuration and the possibility to provide customers with renders.

Importing articles from pCon.planner or from pCon.xcad will be the most common way to create your article
list. By using these two applications you can take advantage of advanced product rules and provide
professional looking renders with the offer.

Please see section on how to summarize articles you have just imported into
pCon.basket.

4.1.1 pCon.planner5

In pCon.planner open the desired project (.fml) file and select Tools = Position Tool Transfer. This command
will copy all the commercial information into the clipboard. Open pCon.basket and simply paste this data
into the article tree section, you can do this by right clicking on your mouse and selecting Paste or simply
through the standard paste shortcut CTRL + V.

Xowiars-BEEs E@ErIes 4 000 @08

Cinna _. A
< weweacrony e [l T R ooupre Y

pCon.planner project Project imported in pCon.basket

Another way is to open the pCon.planner project (.fml) in pCon.basket. All articles will be inserted as planning
articles and have to be converted into standard basket articles. This is done by selecting Extras > Convert
Planning Articles.
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4.1.2 pCon.planner 6

In pCon.planner open the desired project (.dwg) file and select Configuration = Copy Article List. This
command will copy all the commercial information into the clipboard. Open pCon.basket and simply paste
this data into the article tree section, you can do this by right clicking on your mouse and selecting Paste or
simply through the standard paste shortcut CTRL + V.

Another way is to directly send the article list to pCon.basket. On the tab Configuration go to Article List. A
settings dialogue is shown. Activate the option Send to pCon.basket and press the OK button. pCon.basket is
started automatically and the articles are shown in the article tree.

If you have defined price settings in pCon.basket (see ) you have to update the imported
articles to activate the discounts (see ).

4.1.3 pCon.xcad

Open the desired AutoCAD project containing OFML data, synchronize the article list and select the File 2>
Export command. Select the .obk format, pCon.xcad will export the commercial data into the native
pCon.basket format. Open basket and simply load the .obk file.

e Spom  me e e

AutoCAD/xcad project Project imported in pCon.basket

Another method is to copy the desired articles in the article list of pCon.xcad. Those articles can then be
pasted into the article list of pCon.basket, for example by using the shortcut CTRL + V.

If you have defined price settings in pCon.basket (see ) you have to update the imported
articles to activate the discounts (see ).

Typically you’ll have the need to insert articles from the catalog if:

®  You have to build a simple proposal where a rendered scene is not needed. You only need
pCon.basket to create an offer.
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®  You haveimported an article list from pCon.planner or pCon.xcad and you just need to add or update
articles.

4.2.1 Navigate catalog

Articles are organized in the catalog following a tree structure. Manufacturers are on the first level, followed
most of the time by the product series. The series and articles can be viewed in the catalog through an image,
making it easy to search and select. To move through the various available catalogues select the image
representing the desired catalog by left clicking it. Notice that next to the manufacturer logo there is a folder
icon, it represents a container of other folders and articles.

To move up one or more catalog levels you have the following two options:

One level up

Select theicon One level up, on the left of the catalog.

Select an entry on the active path in the catalog's toolbar. The path
shows the currently open catalog, the series and other sub folders
selected so far. It quickly tells you how deep on the catalog tree you
are. You can jump through various catalog levels by clicking on the
desired level.

Manfacturer > Sedus Office Fumiture > Accessories

4.2.2 View catalog

You can edit the view of the catalog series and articles by selecting the buttons located in the upper part of
the catalog

Only Symbols: the articles are only viewed graphically

Large Symbols and Text: the articles are viewed graphically as above but a brief
g explanatory textis included

SYSTEM 393

Small Symbols and Text: the articles are viewed graphically as small icons and a

k g . .
IERMER  brief explanatory textis included

-

& SYSTEM 39 List: the articles are viewed with their text and without images

Listand Description: the articles are viewed with their code, without images and

Qusystemas i g description
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You can also have control over the dimension of the icons in the catalog, to adjust them right . . ...
click on the mouse anywhere in the catalog and a new window will appear giving you several ® terge inages
visualization options. -
100%

150%
200%

4.2.3 Insert article

In pCon.basket, you can insert an article by using the electronic catalog or through the article search. An
articleis interactively selected as follows:

e  Open the folder that contains the desired article

e Selectthearticle by clicking on it

® Thearticleis entered into the tree structure.
pCon.basket enters articles using the following rules:

* Ifnoarticlein the offer tree structure is selected, the new article will be entered in the last position
of the tree structure

e If an article in the tree structure is selected, the new article will be entered directly after the
highlighted article at the same level

e |fa folderis selected, then the article will be entered inside the folder

The newly inserted article becomes automatically selected.

The article search allows you to define search parameters in order to find an article. This procedure is useful
when you don't know the location of a needed article in the catalog. An article search can be activated by
selecting the Article Search tab located in the top left of the catalog.

Tray | Aticle Search |

Search. [[ Rl Search Search using wildcards -
Search in article numbers >

[~ Consider case
[~ Extended expression [+, -, ")

i ¥ Search all seres

I Include folder names
Variants: | | Create

Article search window

To carry out an article search, perform the following operations:
e Definethesearch specifications: enter a key word or phrase in the Search field.

e Definethesearch options: select the search parameters (exact word, partial text, etc...).
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e Startthe search: press the Search button to the left of the field for the search text.

The table will show the retrieved results. For each article found, the article number, the name of the series
thatit belongs to and a descriptive text are shown. If the search provides more than one result, the firstline is
automatically selected and the corresponding image is viewed.

To enter the article found in the offer tree structure, double click or hit the Create button on the side of the list
of articles found. The article will be entered based on the previously described rules.

NOTE: The search starts automatically at the current manufacturer selected in the catalog. Articles in other
manufacturer catalogues will not be part of the search.

The ﬂ button located to the right of the results table allows the user to go directly to where the article is
found in the catalog. The Variant field allows the user to refine his/her search based on the article's variant
codes.

4.3.1 Search Options

You can personalize your search through the usage of several options:

e Search using wildcards; if you only know one part of the article code, you can search for it using a
wild card * or ? to replace parts of the article code.

®  Exactsearch; this search will find the article that exactly satisfies the search term. The text must be
complete and correct.

®  Exact search (substrings); this option is similar to the above but this time the results list shows
articles whose names include part of the typed string.

®  Fuzzy search; in this case, the search procedure also provides results that differ slightly from the
indicated search term. This option can potentially produce a successful search when you make a
typo or don't remember the exact full name of an article. All the terms that are generated by adding or
removing a letter at the end of the search are also considered.

®  Search in article numbers; the program will look for the part of the code entered in the article code.

® Search in catalog texts; the search parameters will be applied to the article text included in the
catalog.

O  Consider case; by selecting this option, the search terms entered will be case sensitive.

O  Extended expression (+,-,"");in an advanced search, the symbols in parenthesis can be used
as operators.

o Search all series; the program will look for the search term in all visible supplier categories
selected. This option is not always available in the program.

o0 Include folder names; with this option, the search is performed by articles that meet the
search requirements and by folder.

© 2016 EasternGraphics GmbH PD - pCon.basket - User Guide 18



EasternGraphics

4.3.2 Article number

All articles are identified by an article number. If you know the exact code for an article, you can enter it
directly in the field on the upper right hand corner above the catalog name bar.

Article number: ﬂ

Article number search field

You can directly enter the article number following the steps below:

e Select a manufacturer on the highest level of the structure. An article number can be chosen only
when a manufacturer folder is open. The search is carried out on all series.

®* Now, you can enter an article codein the Article Number field.

®  When you find the desired article code confirm your selection by hitting ENTER. The article will be
added to the offer.

® Thelastentered article number stays in the field until after the article is added to the offer and can
be edited or overwritten.

NOTE: When you start to enter a code in the article number field, you will be automatically offered the
article number nearest to the already entered string.

User articles are articles created by the user, which have total control over all of the article’s commercial
properties, which is not the case with a normal catalog article. You can use a user article to enter articles or
services which are not available in the catalog, they may include:

® aspecial article, like for example an article with a special shape or a special finish
® an article for which you don’t have an OFML catalog in pCon.basket. If you represent other

manufacturers that still don’t have their data in the OFML format you can create them as a user
article.

® Special services you need to charge to your customers which are not dependent on the value of other
article. For example if you want to charge a transportation or installation fee, which is independent
from value of the other articles in the offer.

User articles will not have any type of intelligence associated with them, since this type of intelligence has to
be previously codified in OFML.
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To create a special article use F4, select Edit > New user defined article or right click on the article tree area

and select New user defined article. You can visually detect a special article through the article’s icon 'ir .

Itis also possible to convert a standard OFML article into a user-defined article. For example you want to
create a special article which is similar to a standard OFML article, only one finish is a special one or you
want to add tax information which are not part of the OFML data. In that case you may don't want to insert all
information for manufacturer, series, short text, long text and so on. You can insert the standard OFML article,
selectitand makein the article tree a right mouse button click on it, so the context menu opens. Select Convert
to user-defined Article. The connection to the OFML articleis lost (also to the intelligence of this articleis lost),
but now you can edit the information of this article and change the necessary values.

Convert to Alternate Position

Convert to user-defined Artide

Calculate Group

Context-menu; Convert to user-defined

Article
Management chair
1 TextID Text name Language Description
Manufacturer Id English EG - Standard
Series Id English GX - Buroelemente
Article Number Base |+| GOIEXSC2
Net Weight KGM -kilogram [ ] 43,2
Quantity 12.00
Purchase Gross Price EUR [ =] 366.00
Sales Price EUR [=] 365,00
ECO-Contribution Seat (plastics) (0,096 EUR/KGM) =
Value Added Tax Standard rate (19,6 %) |z|
10 Short text Geman Management chair
20| Long test (Geman Management chair
Back rest: high
PAmmrest: T-Amrest
30| Variant text (Geman Headrest: Yes

Seat uphalsteny: Sky
Back upholstery: Sky

Foot: Chrome
40 reserved {not for use at this mo| Geman |z|
71| Special Mode! Information Geman Iz‘
@add | Additional text Geman Iz‘

Aicle List | Configuration | Aticle Calculation | Header Calculation | Tevts/User defined Aticles | Catalog Information |

Tab Texts/User-defined articles after conversion of a standard OFML article

NOTE: The availability of the function Convert to user-definde article depends on whether you have
pCon.basket license type B.
The fields Net Weight and ECO-Contribution are only visible if you have a license for the

and selected the country France with the variant with ECO-Contribution in the Project

Settings.
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visualize your business

Aline breakinside a field is done by pressing Shift + Enter or Alt + Enter. For editing the text inside a field make
a doubleclick to the field or press F2 when the field is selected.
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The article list gives you detailed information about the articles contained in pCon.basket. The structure is
organized in cells, each row represents an article and each column different information like quantity or
description.

The article list makes it easy to have a quick overview of the complete offer and provides an easy way to
perform quality control, given the fact that the images represent the finishes of the final articles.

On the left side of the article list in front of the article numbers different icons are visible which give
information about the update state of this article. For further information please have a look to section

Postion | Manufacturer | Series [ Aride number | Prei ShortDescrption | LongDescrption | FeatureDescrition | Quantty] 5P [ TP =
i E GX | GOIBXCET Wingdoor cupboard | Wing-door cupboard | Width: 800 mm 700 101580 101580
Height: 2000 mm 101590 101590
Depth: 400 mm
Cupboard Socle: Sumour
s1 Hendle: Curved metal
Corpus: Alerce
Frort: Alerce
Boards: Alerce
Base: White sluminium
Hendle: White aluminiur
2 ES GX |GOIEXC03 Container wih drawers Contaner wih draner| Widih: 450 mm T00| 32030 32030
Heicht: 720 mm 2030 2B
Depth: 800 mm
Exension length: 0 mm
| Orgarisation: 3/3/6
Hendle: Curved metal
Corpus: Alerce
Frort: Alerce
Plte: Aerce
Hendle: White aluminiur
3 ES GX |GOIEXSCZ Wanagemert charr wit| Management chair wi| Back rest: High T00| 121600 121600
amvest. Tamrest 121600 121600
Lordose pads: With
Fols: For melamin
o Seat upholsery: Black
Back upholsery: Black
Foct: Chrome
s Amrest: Aerce
* Lordose pads: Black
[ ES GX|GOIEXTAT Table. corfig. sideab| Table, config.. sideab| Plate type: Normal shape| 100 89420 89420
Frame: Wheter fourlega: 8420 63420
Width: 1600 mm
AT, Depth: 800 mm
v ¥ M Height adjustmert: Freepf
Tabletop: Alerce
Frame/Rack. Anthrazi
Foot: White aluminium
Linkina: None
Document Gross Price: 3.446.40 EUR: Value of Goods: 3.446.40 EUR: VAT (19.00 %) 654,82 EUR: Final Amount: 4.101.22 EUR: Margin: 0.00 EUR (0.00 %) |T|

<
w
=3
—

Aticle List | Corfiguration | Aicke Caleulation | Header Caleulation | Tents/User defined Articles_| Catalog Infomation

Article list

pCon.basketis installed with the following default columns.
® Position; this column shows the position of the article in the tree structure. pCon.basket
distinguishes between primary positions, named with natural numbers, and secondary ones, for

example "2.1".

®  Manufacturer; all suppliers appear in the software with a identification abbreviation. The
manufacturer is unique.

®  Series; this column specifies the product series of the article with an identification code. The product
series abbreviation is unique.

®  Article Number; the article numbers describe only one article and its configuration.

®  Description; the information on the article is included here. This set up allows you to see the long
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description and characteristics of the article.

®  Quantity; the quantity of the articles is specified here and can be manually changed. Just select the
corresponding cell and type the new quantity value, note that the article price will be automatically

updated.

®  Price;the net priceis the price of the article without any discounts and before VAT.

® Total Price; the total net priceis the net Price times the specified quantity.

®* Image Preview; this column contains the image preview of the selected article. The finishes in the
drawing always match the finishes selected during product configuration. This allows you to do a
quick visual check on your list.

You can create as many article list views as you need and switch between them. For example, you can create a

view without prices if you have the need to work together with a customer organizing an offer.

To create a new view select View = Configure Basket Views...

5.2.1 Select

In the Select tab the existing views are listed - you can add, delete or rename them. The standard view cannot

be deleted or renamed.

By clicking on the Set Current as Default button you’ll set the currently selected view as the standard, i.e., this
view will automatically appear next time the project is open. If you select the option Include in Default Styles,
then the current view will be stored in pCon.basket view database and it will be available for all future
projects. If not active it will be available only for the project the view was created on.

-

o=
=

Basket View Settings for current Project =

Cument Style: OrganizerView

Select |Cc|umn5 |D|splayMcda

OrganizerView
Standard

Default View: Standard Set Cument as Default

[F] Add to predefined views for new projects

This diglog configures the views of the cument project only. The view configuration for new projects can be
changed within the preferences dialog {menu "Bdras > Settings..."}in the preferences page "Basket /
Bashet View".

Add... I I Delete I [ Rename... I

(S——————
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To create a new view click on the Add... button. Enter the view’s name and select which current view you want

to base your new view upon. Select the view which has more common elements with the one you would like to
create.

e

€< New View % |[==

Create new view as a copy of :

Crganizeriiew

[]

Clle Cancel

New view creation

5.2.2 Columns

In the Columns tab you’ll define which columns you want to display in the workspace.

To add a column to the Visible columns list select a column on the Available columns list and click on the Add -
> button. To eliminate a column, select a column on the Visible columns list and click on the <- Remove button.

You can also order the columns by selecting the column you want to move and clicking on the Up or Down
button.

-

“e_, Basket View Settings for current Project

EEl

Cumrent Style: OrganizerView

Columns | Display Modes

Available Columns Visible Columns
Aticle Image - Position
Catalog Image ] Manufacturer
Description Series
ECO-Tax Adticle number
Generated Image E Bdd - Preview
Image Editable Short Description
Leadtime - Bemaove EditableLong Description
ManufacturerCode L EditableFeature Description
ManufacturerRegion Guantity
Packaging Single net price
Single gross price Total net price
Single purchase price
Sinnle ealss nrice S
Delete Edit Lp Diown
Automatic Column Width

Column tab of the view setting window

You also have the option to create new column to your view. Click on the New button and a new window will
appear where you can define the new column properties.
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= New Column ® [ £
Title: Col31
Name: Column 31
Type: Text |Z|
Default Column: | <no defauft>
Default Text:

Column Read Only

ok || Ccancal

New column creation window

You can define the following properties:
e Tijtle, the column title will be displayed on the top of the column in the workspace
®  Name, the name displayed in the selection list of available columns
® Type, thereareseveral available column types

o Boolean, provides the option to activate annotations/commentary about the logical value of
a statement

O  EClass Id, with this type the E-class Standard is imposed, by which articles are uniquely
identified

o Image, allows to load an image
O Number, allows to specify a numerical value
o Text, allows to write descriptive text
e Default column, allows you to specify if the column is based on one of the default columns

®  Default text, allows you to specify the default text for the selected column. Via placeholders you can
also access several characteristics of an article. The following placeholders are available:

Placeholder Description

$(SingleTax:<tax-type>) Calculated single tax price of an article

<tax-type>represents a valid tax type in the selected tax scheme. Currently
the following are available

= VAT

* ECO_FR
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Placeholder Description

Example:

S(SingleTax:ECO_FR)

S(TotalTax:<tax-type>) Calculated total tax price of an article

<tax-type>represents a valid tax type in the selected tax scheme. Currently
the following are available

= VAT
» ECO_FR
Example:

S(TotalTax:ECO_FR)

$(TaxRate:<tax-type>) Tax rate valid for this article

<tax-type>represents a valid tax type in the selected tax scheme. Currently
the following are available

= VAT
* ECO_FR
Example:

S(TaxRate:ECO_FR)

$(TaxCategory:<tax-type>) Tax category valid for this article

<tax-type>represents a valid tax type in the selected tax scheme. Currently
the following are available

= VAT
* ECO_FR
Example:

S(TaxCategory:ECO_FR)

$(Packinfo:<pack-info- With this placeholder you can access the packaging information of the
type><opt-unit-and-precision>) article

Via <pack-info-type> you can access a specific element of the packaging
information. In detail these are:

= Width
= Height

= Depth
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Placeholder

Description

Volume

TaraWeight (Weight of the pack unit)

NetWeight (Weight of the article)

ItemsPerPackUnit

PackUnitsPerArticle

<opt-unit-and-precision>is optional, so it can also be left empty. Otherwise
you can control the unit <unit> and the precision <precision> of the
displayed value.

If the field is empty the default unit will be either MTR (meter), MTQ (cubic
meters) or GRM (gram) and full precision is used.

The following <unit> entries are available:

Length:

MMT (millimeter)
CMT (centimeter)
DMT (decimeter)
MTR (meter)

INH (inch)

FOT (foot)
Volume:

MTQ (cubic meter)
INQ (cubic inch)
LTR (liter)
Weight:

MGM (milligram)
GRM (gram)

KGM (kilogram)

LBR (pound)

<precision> has to be an integer and defines the desired number of decimal
places. The maximum number of decimal places is 16.

Example:
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Placeholder Description

S(Packinfo:NetWeight[KGM:1])

S(PriceDate) Show the price date set for the article

A user-defined column which shows all importantinformation for the ECO-Contribution could be defined like
the following:

<=, Edit Column [ B[]

Title: ECO-Contribution

Name: ECO-Contribution

Type: Tend

) Default Column: | <no default>

@ Default Text: Met Weight:  ${Packinfo:MetWeight[KIGM:1])
Cateqony: {TaxCateqory:ECO_FR])
Article: &(Single Tax:ECO_FR)

Pasttion: &(Total Tax:ECD_FR)

[ Column Read Only

oK H Cancel

User-defined column for showing the ECO-Contribution

The result would look like the following in the Article List:

Posttion Hersteller Sere  Artkelnummer Beschreibung ECO-Contribution Menge EP GP
1 ®Y CH  |Chairl Visitorchair Net Weight: 68,2 KGM 1,00 250,00 250,00
f Position net price Category: Seat [plastics) 250.00 250,00
Article 655 EUR
Position: 655 EUR
2 wY CH | Chairl Swivelchair Net Weight: 58,3 KGM 200 359,00 798,00
2 Postion net price Category: Seat (metal) 3599.00 798.00
Article 544 EUR

Position: 18,88 EUR

Document Gross Price: 1.048,00 EUR; Value of Goods: 1.048,00 EUR; ECO-Contribution: 25,43 EUR, VAT: 210,39 EUR; Final Amount: 1.283,82 EUR; Margin: 0,00 EUR (0,00 %)
Article List Corfiguration Adticle Calculation | Header Calculation | Texts/User-defined Aticles | Catalog Information |

User-defined column ECO-Contribution in the Article List

NOTE: Please note, that the tax and packaging information can only be shown if they are maintained in the
OFML data by the manufacturer.
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5.2.3 Display modes

In the Display modes tab, you can define two further view options:

‘?4 Basket View Settings for current Project I ? 23

Cument Style: OrganizerView

Select | Columns | Display Modes

Discounts

[] Hide discounts not marked as visible

Planning oriented
Always expand groups
Treatment of Set Aticles: | Expand [+

[ ok ][ conce

Display mode tab of the view setting window

® Hide discounts not marked as visible, activating this option will hide all non marked discounts from
the article list view. You can mark discount/upcharges in the Calculation tab. In the following image
‘Discount 1’ is marked as not visible while ‘Discount 2’ is marked as visible.

[ iption
Straight work top 60 cm. deep cm. 5060 vg
Di i 1 additi 1 ot Straight work top 60 cm. deep

cm. 3060
r j Discourt 1 fvertical grain)
v _=| Discount 2

cm. W30xD60xH25
Surface’s colour: pear
Fixed code: 15016410BD
Discount 2 (5.00 %)
Posttion net price

Calculation tab, discounts section Article list view

e Always expand groups, if active all groups will be always expanded.
® Treatment of Set Article, says how Set Article should be displayed:
O  Expand, the sub-positions of the Set Article will be visible.
O  Collapse, the sub-positions of the Set Article are not visible.

o Dynamic, in the article tree you can decide for every Set Article how it should be displayed -
collapsed or expanded.

For further information on Set Articles see section
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To apply a view to a project go to View = Change current basket view... and select the desired view. If you
change a project’s view, close the project and reopen pCon.basket will present the project’s defined default
view.

There are two types of default workspace views that you can set up. One is the project default view and the
other is the application default view.

Project Default View

If you want your project to have the same permanent default view, independent if you close and reopen it in
the same or in a different computer, go to View = Configure Basket Views...

In the new window select the view you want to be the default, click on the Set current as default button and
select Ok. From this moment on this will be the project’s default view. For example, if you change to another
view, save the project, close and reopen it, the defined default view will be applied.

Application Default View

If you want to define a default view valid for all new projects, go to Extras > Settings > Basket View. In the
new window select the view you want to be the default, click on the Set current as default button and select Ok.
From this moment on this default view will be applied for new projects. Make sure that when you create the
view as described in section , you select the option Include in Default styles.

If you want to add this view also to existing projects (e.g. you get a pCon.xcad project from a colleague) select
the box in the column Add to existing projects.

Go to View = Configure Basket Views..., select the view you want to delete and press the delete button. Be
aware that you cannot delete a view that is defined as the default view. You’ll have to define another view as
default and only then you’ll be able to delete the view. From this moment on the deleted view will not be
available for new projects.

You can choose which type of description to view in the articles list Description column. Select the command
View > Position.

Choose between the following entries:
e Standard description, displays the default description text

® Short description, displays the short description text
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® [ong description, displays the long description text

® Article features, displays the article’s properties which can be configured. This is a dynamic field since
itis automatically updated when the user changes the products properties

® Additional text, displays the additional text entered under the Text/User Articles tab in the workspace
area

® Price Components, displays the composition of the articles list price

Several of these descriptions can be viewed at the same time (for example, Long Description and Article
Feature). There’s not a standard on the information included in each one of these fields, the information is
depend on the decisions of each manufacturer.

In pCon.basket you can manipulate the defaultimage or you can completely replace it by an imagine of your
choice.

5.7.1 Manipulate current image

NOTE: The following can only be done if you have a pCon.basket licence type B.

Manipulation of an image is not a frequent task, but you may want to change it to highlight for example a
product feature that in the standard view is not visible.

To manipulate the current image select the desired article and go to the Configuration tab. There you can
rotate the article and specify some of the image’s properties in the View and Camera tabs. See section
and for further details.

When you have the image you were looking for, select the command View = Generate New Image or CTRL +G. If
you go to the article list you'll see that pCon.basket has replaced the standard image with the new one you
just created. This image is going to be used by the print manager when you create the printed or electronic
offer.
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Modified image

Postion | Manufacturer | Series | Previewimage

Adticle number

Description

1 ] AV

AVPA

Conference ar waiting area amchair
Corference or waiting-area amchair
on castors or glides

cm WE1xD57xH79.2

Surface’s colour: 82/0075

‘Wheel's kind/sliding: Castors

Fixed code: 1117136RH7S

Pasition net price

Article list with new image

You can easily set back the standard view through the command View = Default Camera Settings. |f move the
object and wish to return to the new defined position select View = Camera like Article Image.

If you wish to reset the image in the article list, select the article and go to View > Reset Article Images.... A
window comes up, where you can define what settings of your image shall be reset. E.g. you like the view of the
image but you don't want it to be shown in grey scale, therefore you deactivate the View Reset. Then only the

colors of the image will be reset and the view will remain the same.
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ﬂ Heset Article Images

[ lgnore predefined settings from product data
The view settings include properties like reference and view pairt,
projection mode, zoom, and image size.
Camera

[v Feset

[ lgnore predefined settings from product data

The camera settings include properties like the use of testures, colar,
gray scale or blackwhite mode, background color, brightness, and
outline mode.

QK Cancel

Reset Article Images

When resetting the image the default settings of pCon.basket will be used. See section and

You can also use this function for several articles at once. Simply select all article for which you want to
update the images and call this function from the menu.

5.7.2 Add external image

If you create a user article it's important to be able to have the choice to associate an image to that article.
Images can also be inserted for folders and Set Articles, this is especially important if you decide not to show
the sub-elements in the printed proposal to simplify the final customer offer. See section for
further information on how to hide a group’s elements.

Ensure you have the column Preview Image in your Article List view. You can find it in the standard
OrganizerView. If you have build a new view see section for further information on how to add a
column.

Right click on the empty Preview Image cell of the desired article or group. A context menu will show up, select
the command Replace Image. A new window will show up where you identify the location of the desired image
file. The typical sources of images are the following:

® Photo provided from the manufacturer. This is the common situation if you are placing an image for
article for wish the manufacturer has no pCon data.

® Render created in pCon.planner. This is the common situation if you want to collapse a group so that
the client is not exposed to unnecessary product details. In this case you can easily make a high
quality render in pCon.planner saveitas a jpg and load into pCon.basket.
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Pasition . Manufadma’l Seneal Previewlmage [Mderkmi:er Description

1 ‘#,- Reception

Group in the article list with new image

You can manipulate the image size and alignment settings for the printed offer. This enables you to easy give
your offers different look and feel solutions. See section Article/Group Print Settings for further information
on how to define these settings.

Pos Description Amount Unit price Total

1 Reception EURG,147.00
This seluticn includes lower blue panels and maple tops.
Its included an executive bladk chalr,

The sides are 2.4m by 2.4m with 1m height.

Printed offer with image width set to 10cm and center alignment

If you wish to reset the image in the article list, right click on the image and context menu will show up. Select
the command Reset Image and pCon.basket will replace the image inserted by you with the standard one.
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After inserting an article you can configure it using OFML’s advanced configuration rules.

Previem lmoge Progestics

THC_B4 TNK 40

= Meta-Propesties
Faredy
Modsh TIKC 43 - Folyamde back 3

- Miscellanenus.
e ™~
Bese hver A,
Sral Back
St i o m tar 7T
S _—
Bacr=e st oo
Backrex fnsh [ =

Article configuration section with the Properties window active

You can configure an article by selecting the Configuration tab in the workspace section. The article list is
replaced by a new interface which is divided in two sections: the preview image and the article properties. On
the lower part of the Properties area there are three tabs:

®  Properties (default); where you can change an articles properties in a quick and simple way

®* View; where you can change the graphical properties of the preview image, like changing to an
orthographic view

®  Camera; where you can change properties of the preview image, like the environment light or the
width of the outline edges

The preview is a 3D image that can be printed, rotated and viewed from several viewpoints by pressing down
on the left mouse button and moving it.

NOTE: The availability of the view and camera setting functionality depends on whether you have
pCon.basket license type B.

Each article entered in a catalog can have various properties. There are two ways to change the properties: if
itis a numeric value, you can enter it directly; otherwise, open a drop down menu with the list of options. All
article property edits are immediately shown in the image preview.

There are two ways to edit properties like finishes or colors:
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Amns I Fixedams
Base Silver Auminium . . . . .
A finish Siver Aluminium
Mechanism Knee tilt synchro T80 T81 T82 Ta3 Te4

Seat Depth Adjustment No
Seat finish group (T} Polyester FR
Seat finish | 5 T85 T86 T47 T89

TS0

Backrest finish group
Backrest finish

Drop down list Preview

Drop down list

If you click on the text of the property, you will activate a drop down menu with a list of possible alternatives.
Preview

If you click on the image representing a property option, you’ll activate a view mode where all possible

options for that property are visible in a series of columns and rows. By selecting one, you'll return to the
initial property view.
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By selecting the View, the following screen appears:
View
Reference Paint x 060 | Y: 035 Z: 0.36
Use Certer of Local Bounds
) View Point X 024 Y. -350| £ 165
@ Polar Coordinates  Alpha: -15° &
Beta: 25
Radius: 347m 3
Projection Mode @ Perspective Projection
() Orthogmphic Projection
Zoom I &
Image Size 256x 256 [+]

[ Crop Image

[[] Complete Image for Composites

Properties View Camera

View tab

Various changes can be made to the image preview:

®  Reference point; using this option, the user picks the rotation center for the 3D object. To change
values, deactivate the field Use center of local limits; otherwise, the reference point will remain the
center of the object. When the field is not locked, a new value can be entered.

® View point; using this option, you can rotate the 3D object and view the selected angle. The user can
change the preview by left clicking and moving it over the view or typing new values in these fields.

® Zoom; using this option, the user can select the size of the 3D object in the preview. The user can also
choose to see it in perspective or orthographic projection. By pressing the right mouse button and
moving the mouse over the preview image you can also zoom in or out of the image.
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L

Perspective View Orthographic View

® |mage Size; using this option, the user can decide the image preview size.

Complete Image for Composites; using this option the image in the article list will show the article
and its sub-articles after generating a new image (see also ). For example it
is possible to show a worktop with its accessories, which have been added by meta properties.
Without this option only the worktop will be shown.

NOTE: The View tab is only available with pCon.basket licence type B.
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By selecting the Camera tab, the following window will appear. This command allows you to set up the type of
view for the desired articles.

Camera
Rendering settings
@ Testures () Grey scale
() Color () Black / White
Realistic representation

Environment
1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1

Brightness: D

Background: D

Outline edges
[7] Outline edges
Line width: |1 2

Properties View | Camera

Camera tab

In the first section, Rendering settings, you can choose from:
®  Textures; view the article with the materials chosen by its properties
®  (Color;view the articlein different colors based on its components
® Gray Scale; view the article in various grays, based on its components
e Black/White; view the article in black and white

®  Realistic representation: The Realistic render mode is the one in which textures and colors appear at
the highest level of quality. This mode makes high demands on the graphics hardware.

In the second section, Environment, you can decide:

®  Brightness; moving the cursor makes the image more or less bright
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®  Background;you can choose the color of the image's background
®  Reset;you can reset theinitial brightness and background.

In the third section, Outline edges, you can decide to make visible the lines outlining an article; you can
choose their thickness and color. By selecting the Reset button, you can reset to the standard configuration.
For some articles, showing the outline edges improves the perception of the details.

Standard image Image with outlined edges

NOTE: The Camera tab is only available with pCon.basket licence type B.

6.4 Global Variant configuration

While creating an offer it's common to have several offer revisions before the final release. These revisions
arenormally based on a customer’s feedback and frequently include changes on an article’s finishes. If your
offer contains few article this is a relative task to manage, but it becomes challenging if it contains dozens or
hundreds of articles.

The correct procedure to mass configure variant changes is as follows:
e Selectsimilar articles with the techniques described in section Selection
e Select Edit = Global Variant Configuration

® The Configuration tab will be automatically selected. Notice on the right side the list of the properties
of the selected articles. This list is a union of the properties of all selected articles. Update the
necessary properties and pCon.basket will update all selected articles.

If you select articles with different properties the union of the properties will be visible. If you change a
property that’s not common to all articles, only the articles with that property will be updated.
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Another possibility to change the configuration of several articles at once is the Profile Manager. In a profile
you can save the configuration of different properties. If an article is inserted or if you assign a profile to an
article all properties of this article which exist in the profile will get the same value as in the profile. For
example you can create profiles for different customers if they always order the same configuration. The
profiles can be exported and therefore shared with other collegues.

The Profile Manager can be found under Extras = Profile Manager ... In the first tab Profiles all existing profiles
arelisted in the middle. You can create, delete, import and export a profile here. Also you can assign a profile
to the articles, control the sequence of the profiles and add entries to the profiles. On the second tab Edit you
see the properties assigned to the profile selected in the tab Profiles.

NOTE: The Profile Manager is only available with pCon.basket licence type B.

6.5.1 Create a profile

With the button New Profile a new profileis created. It is shown in the table in the middle of the dialogue. By
clicking in the field Profile Name you can edit the name of the profile. The column Active shows whether the
profileis assigned to an article during insertion of the article.

E Profil Manager Elgl
Frofies | Eot |
New Profile e Delete Frofile
T Active| Profile Name | Export Prei
Impa e o e
£ Mew Configuration Profile I
Assign Profile T
Selection
Move Down
Al Atticles

Description Add Ertres

™ Manufacturer
* Program
" Property Class
" Aticle

Close

Profile Manager window

To add a properties configuration to this profile, insert an article and configure it. Then select the properties
you want to add to the profile by clicking in the first column of the property editor. A green check mark will be
shown at this position.
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Checked properties

EasternGraphics
Width 0.800m Width 0.800m
Height 2000 m Height 2,000 m
Depth 0,400 m Depth 0.400m
Cupboard Socle f—, Sumounding Cupboard Socle —= Sumounding
Handle e CUrved metal Handle e CUrved metal
Corpus Beech v Compus Beech
Front Beech ¥ Front Beech
Boards | | Glass Boands | | Glass
Base | R v Base | EEEE
Handle | S Handle | EEEE

In the Profile Manager select the profile to which you want to assign the configuration. At the bottom right of
the Profile Manager window the button Add Entries is enabled. Select on which level you want to add the

configuration:

Add Entries

L

Manufacturer
Pragram
Property Class
Article

®  Manufacturer: The configuration will be assigned to every article of the manufacturer the properties

come from.

e Program: The configuration will be assigned to every article of the product line the properties come

from.

®  Property Class: The configuration will be assigned to every article which has the same property class.

e  Article: The configuration will always be assigned to the article, where the properties come from.

If you now switch to the tab Edit you will see those properties. All properties are sorted by manufacturer, so if
you want to see the properties of a different manufacturer you have to select this manufacturer in the drop-
down list at the top left of this window. With the drop-down list Program you can filter the shown properties

configuration by product line.

With the button Delete Entries the selected configuration is deleted. With the drop-down list at the bottom left
you can select whether to show only the Symbols, only the Text or Symbol and Textin the table.
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E Profil Manager E]
Profles | Edt |
Manufacturer: | Standard ﬂ Program |7al\ programs — ﬂ
Program Adicle Property Class Property Property Value
1 (Cffice elements GOIEXCB7? OI_NONE_PROPCL)| Front Beech
2 Cffice elements GOIEXCBT OI_NONE_PROPCL| Corpus Beech
3 Cffice elements GOIEXCBT OI_MONE_PROPCL| Base Steel blue
Text 7 Delete Entries
Close

Tab Edit of Profile Manager

6.5.2 Assign a profile

A profile can be either assigned when an articleis inserted or after the insertion if the user assigns explicitly.

All profiles which are marked as Active in the profiles list will be assigned to the inserted articles. If there are
several profiles active and there is a conflict because they have for example the same property with a
different configuration, the order of the profiles decides about their priority, whereas the top profile has the

highest priority.

Prafiles

Active| Profile Mame
v |LPA
Chairs
[ |Hansen

The first two profiles are active and will be used when inserting an article. “LPA” has the highest priority.

To change the order of the profiles use the buttons ‘Move Up’ and ‘Move Down’ at the right side of the

dialogue.

Maove Up |

Move Down |

For the post-configuration of articles the two buttons under Assign Profile have to be used. Activate the
profiles you want to use in the column Active of the profile list. Then you can assign this profile only to the
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selected articles by pressing the button Selection or you can assign it to all articles by pressing the button All
Articles.

6.5.3 Exchange of profiles

Itis possible to exchange profiles between different workstations. A created profile can be exported. For this
select the profile in the profiles list and press the button Export. Afile dialogue comes up and asks you for file
name and the directory where to save the profile. All profiles are saved as cpx-files.

A saved profile can be imported by pressing the button Import. Select the profile file (file extension .cpx). In the
profile list the imported profile will be shown.
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pCon.basket offers can be structured through folders, each representing a group which can contain articles or

further subgroups. Group creation is very useful since it allows articles to be organized in a more logical
way.

If you import a project from pCon.planner or pCon.xcad where you had previously created groups, they will be

visible in pCon.basket. See section for further information on importing articles from the other pCon
modules.

If you are working in a project started in planner/AutoCAD and the project contains many single articles, it's
recommended to create the groups in those applications. It's much simpler to accomplish it in CAD
applications because you can visually select the articles.

Each tree structure position is assigned an individual position number. Position numbers are assigned
progressively. In each level of the structure, the first position is number 1. The following position is number 2.
Secondary positions have a corresponding number that refers to the upper level. For example, if position 1
has a secondary position, this will be number 1.1. The second secondary position will be numbered 1.2.
Position numbers are automatically assigned by pCon.basket.

Pozition

1
1.1

B
5
z
21

Position numbering

There are seven types of positions in pCon.basket:

| Folders (F3); folders are structure elements which can contain other folders or articles. Folders allow the
user to join individual positions into groups. To add a folder, select the desired folder position and use
the command Edit > New folder, you can also use the key F3. To change the folder name, left click on the
highlighted folder and enter a new name, you can also use F2. pCon.basket doesn't allow folders to be
placed under articles.

& Articles; are added through catalog selection, import or article search. Articles can contain other articles
or text positions as sub elements. There are three different types of articles:

. gStandard Article; they have standard OFML properties.
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o & Metatype Article; they have advanced properties, so called Meta-Properties. See section
for further information.

o« & Planning Article; they are inserted from a pCon.planner project (.fml-file) and have to be converted
to standard pCon.basket articles (see section )

& User-defined article (F4); these articles can be created directly in pCon.basket by the user through the
command Edit > New user-defined article, you can also use F4.

& Text position (F5); with pCon.basket, the user can create text-only positions in the tree structure. This can
be useful to better describe articles or a proposal section. You can create them through the command Edit
- Create New text position, you can also use F5. Text positions share the same rules of the articles. You
cannot associate prices to text positions.

¥ Set Article; those articles are similar to folders, but they can get further information like quantity,
manufacturer, product line etc. The price of the Set Article is calculated according to the prices of its sub
positions. A Set Article can't contain another Set Article. To create a Set Article make a right mouse button
click on a folder and go to Set Article > Create Set Article. See also section for more information.

An offer can be structured in groups and subgroups for a clear organization. For example, an offer could have
a group called ‘Administrative Office’ under which there could be several subgroups, for example ‘Accounting
Office’ and ‘Meeting Room’.

The creation of groups allows you to:
e Quicklyidentify specific articles
®  Present an organized offer to the customer
e Display partial totals
e Present different discounts for different groups

e Simplify a multi article product to the end customer. There are products which are represented by
multiple articles. You can insert all these articles inside a group and show only the group header in
the printed offer. Normally the end user isn’t interested to know how much a beam or a bracket costs.

If you imported a project from pCon.planner or pCon.xcad where you had created groups, pCon.basket will
recognize those groups. This is the usual process for a project which involves a drawing.

There are two different types of groups:
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7.3.1 Folders

Folders are structure elements which can contain other folders or articles. Folders allow the user to join
individual positions into groups.

To create a folder select the command Edit = New folder or the shortcut F3. If you have a folder selected and
insertan articlein the article list, that article will be automatically inserted under that folder. To change the
folder name, left click on the highlighted folder and enter a new name, you can also use F2. pCon.basket
doesn't allow folders to be placed under articles.

7.3.2 Set Article

With Set Articles several articles can be summed to one article item. The user can enter information of
manufacturer, product line, article name, quantity and texts to this item. The price of the Set Article will be
calculated automatically according to the contained articles (incl. quantity and discounts) and the quantity
of the Set Article itself.

The user can decide whether to display a Set Article collapsed or expanded in the basket view. According to
this setting the offer will be printed.

Create Set Article

To create a Set Article at first a folder has to be created. Make a right mouse button click on the folder in the
article tree. In the context menu go to Set Article = Create Set Article. In the sheet Texts/User-defined Articles you
can now add all the information of the Set Article.

Break up a Set Article

To destroy a Set Article make a right mouse button click on the Set Article in the article tree. The context menu
comes up. Go to Set Article > Break up Set Article. The Set Article is a folder again. Please note that the quantity
of the grouped articles has not changed. If you make a Set Article out of this folder again the earlier quantity
of the Set Article will be shown again.

Add further positions to a Set Article

Select the Set Article and add an article from the catalog. This article will be added to the Set Article
automatically. The price of the Set Article is updated.

To add a user-defined article make a right mouse button click on the Set Article and select New user-defined
article. Or select the Set Article and press F4. You can also add folders or text positions in that way.

If you just move an article in the article tree under the Set Article it will not automatically be added to the Set
Article. For doing this make a right mouse button click on the article you want to add and go to Set Article 2>
Add to Set Article.

Remove a position from a Set Article
Select the position you want to remove and delete it. The Set Article is automatically updated.

Simply moving the position in the article treeis not sufficient to remove the position from the Set Article. For
this select the position you want to remove and make a right mouse button click on it. Go to Set Article >
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A Set Article can be shown expanded or collapsed in the basket. This can be configured in the basket views. Go
to View > Configure Basket Views... In the tab Display Modes the Treatment of Set Article can be set.

®  FExpand: All Set Articles will be shown expanded in this view.

e (Collapse: All Set Articles will be shown collapsed in this view.

®  Dynamic: For every single Set Article it can be choosen whether to show collapsed or expanded. For
this select in the article tree the Set Article and make a right mouse button click on it. Under Set

Article there are now two further options Collapse Set Article and Expand Set Article.

For further information on article list views see also section

In the tree structure selected positions are highlighted with a blue background, in the article list with a grey

background.
Desciiption Positio| Manufacturer] Series| Aticle number Previenlmage: Description P i3 B
-1, 1t Floor 1| st Floor
[=8 W 1. Meeting Room 2 11 Meeting Room
B # 1_Corference- and Side table: 111 |EG GX  |GOIEXTAL [ Conference- and Side table 185820 185820
& 2 Management chair with optional am r. v'3 i il Posttion net price 1,858.20 1,85820
(8 3. Lower cupboard wih fiap door | !
... — 112 |G GX  |GOIEXSCZ Managemert. chair with optional am rests 06400  6.384.00
SR b Postion net price 105400| 638400
£ 2. Manager Ofice A ]
&7 1. Comer work place, 90° V4 g
&7 2. Management chair with optional am rests St
g7 3. Wing-door cupboard £
113 |G GX  |GOIEXCES Lower cupboard with fiap door 12680 12680
i Postion net prce 12680 12680
V5 ‘,_/I
114 |G GX | GOIEXCET Upper cupboard with drawers S0450( 90450
Postion net price 90450 50430
vE
e Wanager Cffice
21 &G GX |GOIEXTAR Comer work placs, 50° TEEI60  1.66360
Postion net prce 166360 166360
Ve
22 &G GX |GOIEXSCZ Wanagement chair with optional am rests 21600 121600
Postion net price 121600  1216.00
e 1R
Pl
¢S

Selected ‘Meeting Room’ group

Furthermore child articles of a selected main position will be shown in light blue / light grey, so you can see
which articles have a connection to a main position. This is helpful for Set Articles and Metatype articles. If
you select the main position of those articles you can see wherein the article list the corresponding child

articles can be found.
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Postion | Manufacturer | Seres | Aticle number_| Previewlmage ShortDescription | LongDescripion | FeatureDescrption | Quarity] SP_ | TP, B
""" 1 T00| 344640 344640

€7 1. EG/ GX/ GOIEXCET/ Wing-daar cupboard _ _ _ _ 34640 344640
72 EG/ GX/ GOIEXCO3/ Cortainer with draw... (EES GX | GOIEXCET Wing-door cupboard | Wing-door cupboard :;gtrr:t ann%r[r:"r:m 100 101530
£/ 3. EG/ GX/ GOIEXTA1/ Table, corfig., side. Depthr 400 mm

42 Office 2 Cupboard Sede: Surour

&7 1. EG/ GX/ GOIEXCH2/ Providing chair 2 Esm:i]l:. gl:r;:d metal
7 3. EG/ GX/ GOIEXSC2/ Management chair with ... Fmr:t Alerce

Boards: Alerce
Base: White aluminium
Handle: White aluminium
12 EG GX GOIEXCO3 Container with drawerz| Cortainer with drawen| Width: 450 mm 1.00 320,30
Height: 720 mm
Depth: 800 mm
Extension length: 0 mm
Organisation: 3/3/6
Handle: Curved metal
Corpus: Alerce
Front: Alerce
Plate: Merce
Handle: White aluminium
13 EG GX GOIEXTA1 Table, corfig . slideab | Table, config., slideab| Plate type: Mormal shape 1.00 834,20
Frame: Wheter fourdega
Width: 1600 mm
AR, Depth: 800 mm
v 4 [ ¥ Height adjustment: Free
) Tabletop: Alerce
Frame/Rack: Anthrazit
Foot: White aluminium
Lirking: None

Page break none 5

: s 21 |G GX |GOIEXCHZ Providing chair Providing chair Seat upholsery: Grey 1000] 23300] 233000
Aticle Image Postion defaut _‘ Back upholsery: Grey 23300| 233000
Adicle Image Width 500cm G j— Frame: White: aluminium

Article Image Alignment left

amrest: T-amrest
Lordose pads: With
e

A

3 EG GX GOIEXSC2 . Management chair wit| Management chair wit| Back rest: High 1.00( 121600 =
T

Selected Set Article; the Set Article children are shown in light blue, one child has been moved outside the Set Article

You can select a position in various ways:
e By leftclicking - the position is selected.

e By left clicking and then moving the mouse while holding down the left mouse button - all included
positions will be selected.

e By left clicking, keeping the SHIFT key pressed and selecting the last position - all the positions
between the two are selected.

e By left-clicking, keeping the CTRL key pressed and selecting other positions - all positions, even if they
are not continuous, will be selected.

® Toselectthe entire tree structure, use the key combination CTRL+A. This is a very useful command if
you want to apply a certain property to all the articles in the offer.

You also have the possibility to select articles by manufacturer, product line or article number. For this see
section

Often during an offer creation there is the need to select articles with common characteristics. For example,
imagine that a customer has decided in the last minute to change the color of all chairs of a specific model
from black to red. This would be a complex task if you had hundreds of chair entries in non sequential places
your offer.

In pCon.basket you can select articles using a powerful filter command under Edit = Select group... A dialog
box will show up where you must define the search options. pCon.basket will automatically select all articles
which meet the defined search criteria.
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B Article Selection

Selection
Pastion: | |
Manufasturer: | K|
Series: |
Aicle Mumber: | K|
& Base Adicle Number [~ Complete Article Number
" Fnal Aticls Number ™ Reguiar Expressicn

Made
* Replace Selection [~ Bdend Selection  Ramaveirom Selection

K Cancel Accept

Article selection window

You can define the search criteria in the upper part of the dialog box, called Selection. In the lower part, you
can determine the current selection methods in the tree structure.

Position

You can use this criteria to select articles by position number. When you select a position number, all articles
that belong to this number or that are found under it are selected. If you open the selection list, all the folders
appear and can be selected. For each folder, pCon.basket first shows the position number and then the group
name.

Selectan

Position: | |
i _ |3 Mesting Room
Ianufacturer: 4 Rleception
Sedes
Aticle Mumber: | =]

Manufacturer

Using this field, you can select all the articles in the tree structure that are associated with a particular
manufacturer. The selection can be done manually or from the selection list. A supplier identification code is
requested for manual entry and the user must know this code. When the code is entered, the complete name of
the supplier will appear automatically. All the suppliers with at least one article in the structure are on the
list. If a position was previously selected, for example, a folder, and you now select a manufacturer, the
articles that fulfill both conditions will be selected.

Pastian |

[KANES

Manufacturer: |

Cl - Howarth ftaly 2007.03.14
SC - Stacicaza Gemany
Adicle Mumber- | SE - Sedus Sioll A

Sena:

Series

This field can be used to search through articles that belong to a particular product series. Series are defined
by an identification code. If it is entered manually, the complete series name will appear. If you use the
selection list, you will see all the valid series. If a user has already selected a supplier, then only the series
that belongs to that supplier and its articles will be shown on the list.

© 2016 EasternGraphics GmbH PD - pCon.basket - User Guide 50



EasternGraphics

Lo Le] Lo

asseltisne professionzli

Article Number

You have the option of searching articles by its code. You can search by the full code or by part of the code by
using standard windows wildcards. You’ll have to be familiar with the codification of the products; you can
see the article codes in the article list view.

You can define four ways for pCon.basket to interpret the article number you inserted:

®  Basic article number; all article in the tree structure whose code starts with the entered part of the
code will be selected.

®  Complete article number; if this is activated in addition to the previous option, you must enter the
exact code of the desired article.

®  Final article number; all articles in the tree structure that end with the entered code will be selected.
The article end numbers can, for example, define the variants of an article.

®  Regular Expression; the typed text will be interpreted as normal text and all the corresponding articles
will be found.

NOTE: pCon.basket is case sensitive.

After defining the selection criteria you can have a quick preview of which article(s) will be selected by
clicking on the Accept button. You have different methods which enables you to merge the result of different
selections.

® Replace selection; it will replace the previous selection with the new one. The current selection is
canceled and the new selection is visible in the tree structure.

®  Extend selection; the new selection is added to the previously selected articles.

®  Remove from selection; the current search results will be removed from the tree structure. This method
is useful if for example you want to select all articles except the ones from a particular
manufacturer. You can select all articles through CTRL+A, do a selection with the manufacturer that
you want to remove and select remove from selection.

You are able to (re)organize articles and folders in the tree structure. You can move article inside folders,
move them out of folders, move them up or down in the tree structure. To select articles and folders, use the
selection techniques described in section .You can move more than one article at the same time.
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7.6.1 Up and down

A position can be moved up or down within the tree structure.
To move a position down:

® Usetheshortcut key CTRL+D

[0
=

® (Click on the Move Down button
*  From the Edit 2 Down menu
To move a position up:

e Usethe quick key CTRL+U

11|
==

® C(Click on the Move Up button

®  From the Edit 2 Up menu

7.6.2 Indenting

EasternGraphics

A position can be indented to the right or the left of the tree structure. This allows you to change the level of
anarticleor a group. Infact,if an articleis reentered to the right, it reenters into the group right above it; if it

reenters to the left, itis at the same level as the group aboveit.

To move an article within a group on to an upper level, the article must be located at the end of the list of

articles.
Increase reentry:

® Usethe shortcut key CTRL+/

b
[

e (ClickonIncrease Indent
®  From the Edit = Increase Indent menu
Reduce entry:

e Use the shortcut key CTRL+ Shift + 1

i
[yl

® Click on Decrease Indent

e  From the Edit = Decrease Indent menu
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Windows’ cut, copy, paste and delete techniques can also be used in pCon.basket. Itis possible to apply them
to both articles and groups.

When you copy a group, pCon.basket will ask you if you also want to copy its sub-elements. The behavior is
similar for the cut and delete commands.

The commands can be found in the menu under Edit.

% Cut Ctrl+X
% Copy Ctrl+C
Paste Ctrl+V
. Delete Del
If you importan article list from pCon.planner or pCon.xcad (see section for further information) you

may find situations where each articleis represented by an individual line, even in case of repeated articles.
Instead of an article being represented by a line with quantity ‘3’, it's represented by three lines each of
quantity 1’

pCon.basket can automatically summarize these quantities. To perform this command first select the articles
which you want to summarize, in most cases it will be all of the articles (CTRL + A), and then run the
command Extras = Summarize Basket Articles.

pCon.basket will group all repeated articles on each level on one single line with quantity n, and with the
corresponded total price. The reason for summarizing products only inside the same groups resides on the
fact that groups are normally independent entities, for example you may need to delete a group while
maintaining the others.

=8 4 1. Meeting Room

- & 1. Conference- and Side table

5;{3 2. Office chair, heigth adjustable, swivel round
5;{3 3. Office chair, heigth adjustable, swivel round
533 4 Office chair, heigth adjustable, swivel round
Q 5. Office chair, heigth adjustable, swivel round
=I- "4 2. Reception

{3? 1. Office chair, heigth adjustable, swivel round
{;,3 2. Table, corfig., sideable top, height adjust ...

— 1 1. Meeting Room
: 3‘} 1. Conference- and Side table
{3,//’ 2. Office chair, heigth adjustable, swivel round
= 1 2. Reception
{;,//1 1. Office chair, heigth adjustable, swivel round
{3{/’ 2. Table, config., slideable top, height adjust...

Before summarizing After summarizing

Notice in the above example that the article 'Office chair' has been grouped only inside the ‘Meeting Room’
folder, maintaining the other copy in the ‘Reception’ folder.

NOTE: The summarizing does not work inside a Metatype for child articles. The connection between parent
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article and child article has to be dispersed before. See section for further
information.

With Metatypes the configuration on inter-product level is possible. For example for a given article not only
the intra-product properties, like colors, can be changed (here, the basic article number remains unchanged)
but even those properties changing the basic article number, such as the selection of another program or
collection is possible. Furthermore Metatyps can contain concatenation and attachment rules, e.g.
attachment of accessories by properties. If an accessory is inserted by such a Metatype property it has a fixed
connection to its father article. For example a desk screen has a fixed connection to a desk.

This connection is sometimes very disturbing when creating an offer structure, because those articles can't be
summarized. Therefore itis useful to delete the connection and only have the single articles.

Select the Metatype father object and go to Edit > Split up Composite Article. You will see the icon of the
articles changes from Metatype to Standard Article (see section ). The connection between the
articles has been completely removed, therefore you can now summarize the articles.

- & 1. Rectangular desk cm. W 180x D 100

& 1. Screen for single workstation cm. W 180 ..
g 2. CPU suspension kit
g 3. CPU suspension kit

Befor splitting the Metatype Article

—g 1. Rectangular desk cm. W 180 0 100
5& 1. Screen for single wordstation cm. W 180 x ...
5;3 2. CPU suspension kit
g? 3. CPU suspension kit

After splitting the Metatype Article

3£ 1. Rectangular desk cm. W 180x D 100
(&
&7 1. Screen for single workstation cm. W 180x ...
fi 2. CPU suspension kit

Summarized articles, which have been Metatype children
before

NOTE: Be careful when using this function, since there is no way to undo it. Also not only the connection
between the articles are deleted but the whole Metatypes properties are removed.
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pCon.basket’s price calculation functions are very powerful and specifically developed to give you full
flexibility to decide the best way to achieve your offer’s economic value. You can arrive to the final offer price
through the normal discount/up charge methods or through reverse calculation.

Contrary to Microsoft® Excel you can easily add new rows without having to worry about updating cell

formulas and formatting.

The article calculation window allows you to manipulate all aspects related with the commercial value of
your offer. The values displayed in the calculation window are dependent of the current articles selected in
the article list. The calculation window can be activated using the Article Calculation tab.

Adicle Calculation

Description Percent Base Absolute Count Total
Price Date 21.04.2018

Base data
Purchase Gross Price 47643 EUR 476,43 EUR
Vendor Discount 0.00% incr. 0.00 EUR 0.00 EUR
Purchase Value 47643 EUR 476,43 EUR
Sales Price 476,43 EUR 1.00x 476,43 EUR

Discounts and additional charges

(7] Discount 1 0.00%  iner. 0.00 EUR 0.00 EUR
(7] Discount 2 0.00%  iner 0.00 EUR 0.00 EUR

Position Met Price 476,43 EUR 476,43 EUR

Header discounts and additional charges
Sondemabatt 500% incr. 23822 EUR 23822EUR
Rabatt 2 0.00% incr. 0.00 EUR 0.00 EUR
Transport 200% PNP 5525 EUR 5525 EUR
Aufschlag 2 0.00% PNP 0.00 EUR 0.00 EUR

Totals
Net Total 462,137 EUR 462137 EUR
Value Added Tax 0.00 % 0.00 EUR 0.00 EUR
Gross Total 462,137 EUR 462137 EUR
Margin -3,093 % 14293 EUR 14293 EUR

Article List Corfiguration Aticle Calculation Header Calculation Texts/User-defined Articles Catalog Information

Article Calculation area

The article calculation window is made up of different columns and rows. The rows are organized in four
sections: base data, discount/up charges, header discounts/up charges and totals. In the first row

additionally the articles
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8.1.1 Select article(s)

The first step in the article calculation process is to select the article(s) for which you want to apply the
calculations. For example, you may want to apply a special discount only to a specific product series because
the manufacturer has a special campaign going on, or you may want to apply certain economic conditions
only to a certain folder.

These are the most common scenarios

e Select one article; under Article Calculation the price of the selected article will appear and you can
apply discounts and up charges to this article only. You can also set the desired amount of that
article.

e Select several articles; using SHIFT, CTRL or the command Edit = Select Group..., you can select several
articles even non consecutive ones. Under Article Calculation the total for the selected articles will
appear and you can apply discounts and up charges for these articles. See section for
details.

e Select agroup;if you right click a group in the tree structure, a menu with the entry Calculate Group
will appear, select it. The Article Calculation section of the workspace will appear. Here you can apply
discounts and rebates for these articles. If the words ‘the number and/or order of the discounts differ’
appearinred, it means that at least one of the selected articles in the group has different features.
Therefore, you must check each article. That can occur if, for example, the discount description is
edited, an articleis added to the group or the group calculation was redone.

e Select the entire offer; if the area of the tree structureis active and you press CTRL+A, all the articles
in the offer will be selected. In the Article Calculation tab the total for the offer will appear and you
can apply discounts or up charges for these articles.

8.1.2 Columns

The calculation window has six columns, they are:
®  Description; describes a row’s values.
®  Percent; the absolute value in terms of percentage.
® Base; the base from which the percentage valueis calculated (e.g. the Sales Price or incremental)

® Absolute; the absolute value in the selected currency. If more than one article is selected and if the
articles have different values, ‘??.??" will be displayed.

®  Count; quantity for the selected article(s). If more than one article is selected and if they have
different quantities, ?.??" will be displayed.

e Total; total values for the selected article(s).

All values colored in blue can be changed by the user; pCon.basket will automatically recalculate all other
values affected by that change.
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This section is the starting point for the whole calculation, since it allows you to set up your sales base prices

and your dealership discounts. You'll find the following fields:

®  Purchase gross price; it's the vendor list price before your dealership negotiated discount.

e Vendordiscount; specifies the discount your dealership gets from the manufacturer. You can enter it
manually or define it one time for all series and it will show up automatically (see section
.Thefirst discount is always calculated on the purchase gross price. For the second and

further discounts you can select whether it should be also calculated on the purchase gross price or

incremental (Purchase gross price - vendor discounts).

®  Purchase value; difference between the gross purchase price and the vendor discount. It’s the price
you pay for the products you resell. On the base of this pCon.basket calculates the dealership’s

margin.

®  Sales Price; the original sales price

NOTE: If you selected a non-discountable article you can not edit the vendor discount and purchase value.

If you place the mouse over the Base Data row and right click, a menu will appear where you can:

®  Add Vendor Discount; adds a new vendor discount

®  Reset Vendor Discount; deletes all vendor discounts

If you place the mouse over the Vendor Discount row and right click, a menu will appear where you can:

e Add Vendor Discount; adds a new discount

e Delete Vendor Discount; deletes the selected discount

®  Move Vendor Discount up; moves the discount one position up

®  Move Vendor Discount down; moves the discount one position down

® rel. to Gross Purchase Price; set the base for the percentage calculation to gross purchase price

® cremental; set the base for the percentage calculation to incremental

Base data
Purchase Gross Price
Wendor Digcount
Special Vendor Discount
Purchase Value
Sales Price
Discounts and additional chames
v j Special Discount
[v ﬂ Transpart
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8.1.4 Discounts and up charges

This section allows you to configure the discounts and up charges for a selected group of articles. They can be

entered as a percentage or as an absolute value.

Discounts and additional charges
v _—| Special Discourt 500% incr. 2750EUR
W | Transport 400% SP 2200 EUR

110.00 EUR
88.00 EUR

The blue Discount 1 and Discount 2 fields can be renamed by selecting them with the mouse. Next to these
fields, there is the symbol '?' which, if selected after entering a discount value in the Percentage or Absolute
columns, becomes '-' or '+'. The discounts are marked with a green minus while the up charges are marked

with a red plus.

If you place the mouse over the Discounts and Up Charge row and right click, a menu will appear where you

can:
®  Add Discount; adds a new discount
e  Delete Discount; deletes the selected discount
®  Move Discount Up; moves the discount one position up
®  Move Discount Down; moves the discount one position down
® rel. to Sales Price; set the base for the percentage calculation to Sales Price

® Incremental; set the base for the percentage calculation to incremental

Discounts and additional chames

v j Special Discourt
v ﬂ Transport Add Discount
Delete Discount
Position Met Price Mowe Discount Up

Header discounts and additional cha Move Discount Down

Special Discourt rel, to Sales Price
Discount 2 v Incremental
| runisetic

E o=

5.00 %
0.00 %
2003

incr.

sp

incr.
incr.
PMP

Next to each discount, there's the option of entering a check mark; if the check mark is removed, the discount

will not appear in the article list but the affected articles will still include the non visible discount.

NOTE: See Extras = Settings = Basket > Basket View = Display Modes > Hide discounts not marked as

visible.
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8.1.5 Header Discounts and additional charges

This section shows the effect of the discounts and upcharges for the whole project. They are only shown for
information purpose. They can't be changed here.

Please also refer to section for more information on how to change the project related
discounts and upcharges.

8.1.6 Totals

The Totals section of the Article Calculation tab allows you to view and set up the following values:

® Net Total; is the original sales price plus or minus eventual (header) discounts and (header) up
charges. This field can be edited, if you enter a value, pCon will automatically calculate the correct
discount or up charge. This is useful if you want to create offers with a defined rounded total. Instead
you could also use the rounding settings in the (seealso ).

®  ECO-Contribution; this field is only visible if you have a license for the
and selected the country France with the variant with ECO-Contribution in the Project Settings.
If the required information (weight and ECO-Contribution tax category) are available in the OFML
data pCon.basket calculates the ECO-Contribution according to the office furniture scheme defined
by Valdelia.

® VAT, the default VAT selected during installation will be shown here. You can change it for each
project. To do so go to Edit = Project Settings = Calculation = VAT. If you have a license for the
you can also work with several VAT values in your project (e.g.

standard rate and reduced rate).

®  Gross Total; is the net total plus taxes. This field can be edited, if you enter a value, pCon will
automatically calculate the correct discount or up charge.

®  Margin; the profit margin of the selected articles. The margin is viewed as a percentage or an
absolute value. To calculate correctly this field you’ll have to fill out the vendor discount (see
section ). The margin value can be manually inserted, in this case pCon will
automatically calculate the necessary discounts or up charges.

NOTE: When you select more than one article, you may see ‘?2.??’ in certain cells in the Absolute column.
This happens when you select articles which don’t share common values. When you select individual
articles you’ll never see the question marks.

NOTE: If you work with the country scheme France and the variant with ECO-Contribution but the OFML
article does not have the required information to calculate the tax (weight and ECO-Contribution tax
category), no ECO-Contribution and VAT will be calculated for this article. The Gross Total fields will
show ???.??. Additionally the article will be marked as inconsistent (red font) and in the tab Configuration
under the properties window a corresponding message will be shown. For adding the required tax
information to this article
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pCon.basket enables you to easily manage an offer’s margin. You can automatically have margins inserted in
your offers by defining a vendor discount for all the series of the manufacturers you represent. This is
normally a onetime effort with a periodical review. The vendor discounts play a very important role in
determining an offer’s margin calculation.

You can set up a standard discount in Extras = Settings = Basket = Prices. In the new window you’ll see all
the available series organized by manufacturer. For each series you can define its default Purchase Price (PP)
and Sales Price (SP). If you want to define the prices on manufacturer level instead of series level please
deselect the option Series-specific Configuration of Purchase Value and Sales Price.

-

<=, Settings [# =]
Category Prices
Common Manufacturer Series Type Percent Base -
= BHS*E:E* oot EG - Standard AC - Zubehérbiblic PV: | 100,00 %|of purchase pice |+
Ez;nkn;:qeﬁmns SP: 100,00 % | of sales price |z|
Prices EG - Standard CA - Designobjelt PV: 100.00 % | of purchase price IEl
Cumrencies and Taxes 5SP: 100,00 % | of sales price IZ|
PItE!ViBW Image EG - Standard G¥, - Biroglemente PV 100,00 % | of purchase price |E|
gl:;E?tl:al settings SP: 100,00 % |of sales price |E|'Z'
Send mail EG - Standard R4 - EGR-Raumel PV: 100,00 % | of purchase price |Z|
SP: 100.00 % | of sales price |E|
EL - Haworth Schweiz AG EU - Euroffice PV 100.00 % |of purchase price |z|
SP: 100,00 % | of sales price |Z|
EL - Haworth Schweiz AG MNC - New City PV: 100.00 % | of purchase price |E|
5P 100.00 % | of sales price |z|
EL - Haworth Schweiz AG PZ - Flaza PY: 100,00 % |of purchase price |Z|
SP: 100,00 % of sales price [~
FE - Febnl Buromobel GmbH 13 - Zubehor PV 100.00 % | of purchase price |z|
5P: 100,00 % | of sales price |Z|
FE - Febnl Biromobel GmbH 16 - Adesso Confe PY: 100,00 % |of purchase price IEl
SP-__| 100,00 %|of sales price [w] ~

Series-specific Configuration of Purchase Value and Sales Price

ok || Ccancel

Price setting window

NOTE: The PP and SP changes will be applied only for article inserted after updating the settings. If you want
to change already inserted articles, select them and manually edit the Vendor discount field in the Article
Calculation tab.
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8.1.7.1 Purchase price

The purchase price defines the discount the manufacturer gives the distributor for a particular product line.
The purchase priceis represented as a percentage of the original purchase price or sales prices.

Imagine that for a product line you specify your PP as 50% of sales price. Insert a new article of the specified
product line go to the Article Calculation tab you’ll see that the Vendor Discountis automatically set up at 50%.

| Description | Percent | Base | Absolute | Court | Total |
Base data
Purchase Gross Price 200.00 EUR 200.00 EUR
Wendor Discount 50.00 % | iner. 100.00 EUR 100.00 EUR
Purchase Value 100.00 EUR 100.00 EUR
Sales Price 200.00 EUR 1.00x 200.00 EUR
Discounts and additional charges
v j Discount 1 10,00 % incr. 20.00 EUR 20.00 EUR
v ﬂ Discount 2 0.00% incr. 0.00 EUR 0.00 EUR
Position Net Price 180.00 EUR 180.00 EUR
Header discounts and additional charges
Special Discount 0.00% incr. 0.00 EUR 0.00 EUR
Discount 2 0.00% incr. 0.00 EUR 0.00 EUR
Logistic 0.00% PNP 0.00 EUR 0.00 EUR
Extra Charge 2 0.00% PNP 0.00 EUR 0.00 EUR
Totals
Net Total 180.00 EUR 180.00 EUR
VAT 19.00 % 4 20EUR M20EUR
Gross Total 21420 EUR 21420 EUR
Margin 44444% 20.00 EUR 80.00 EUR

Calculation example

Let’s look at the example of the above article. Notice that the margin is €80 which is the difference between
the Net Total and the Purchase Value (€180-€100). If you don’t define a vendor discount you’ll always have
negative margins.

8.1.7.2 Ad hoc vendor discounts

Imagine you managed to negotiate an extra discount for some specific articles, maybe due to the size of the
order or due to the fact that it contains a product series in promotion. You can specify extra discounts by
placing the mouse over the Base data row and right clicking it. The following menu appears:

e Add vendor discount; allows you to add a new discount line in this section.

® Resetvendor discount; deletes the discount line entered with Add Vendor Discount.

Description | Percent | Base | Absolute | Court [ Total | [ Desotption [ Percent [Base [ spsoits [ Count Total

200.00 EUR
40.00EUR

8.00 EUR
152.00 EUR

Purchase Gross Price 200.00 EUR
incr. 40.00EUR
incr. 8.00 EUR

152,00 EUR

200.00 EUR
% iner. 40.00 EUR
160.00 EUR

200.00 EUR
40.00 EUR
160.00 EUR

Purchase Gross Price
Vendor Discount

Vendor Discount

Promation
Purchase Value Purchass Value

Sales Price 200.00 EUR 1.00x 200.00 EUR Sales Price 20000 EUR 100% 200.00 EUR

Original discount (20%) Added extra vendor discount (+5%)
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Alternative position allows you to mark a position as alternative to the main proposal. For example, imagine
thatin a previous sales discussion the customer was undecided between two chair models, you can present
both in the offer, marking one as alternative.

Positic Manufadurer| Series| Aticle number | Previewlmage | Description | Quant'rty| SP | TP

1 EG GX GOIEXSC2 Management chair with optional am rests 1.00| 1.216.00 1.216.00
Back rest: High
amrest: T-amrest
Lordose pads: With

1 ? Rolls: For melamin
W1 3 Seat upholsery: Black
h Back upholsery: Black
Foot: Chrome
L
[ ‘Q
[

Amrest: Beech undamped
Lordose pads: Black

& Position net price 1,216.00 1,216.00
2 =8 GX | GOIEXSCT Office chair, heigth adustable, swivel round 10| 55000 550.00
Sear upholsen: Black
Back upholseny: Black
v'2 Foot: Chrome
™ Position nef price 550.00 55000

Document Gross Price: 1,216.00 EUR; Value of Goods: 1,216.00 EUR; WAT (15.00 %): 231.04 EUR; Final Amount: 1,447.04 EUR; Margin: 0.00 EUR (0.00 %)

Article list with an alternative position (#2)

To mark a position as alternative, follow these steps:
e Select the position
e Select Edit > Convert to Alternative Position, or right click and use the short menu

An alternative position can be visually identified by the writing in italics and presenting the Total Price in
gray. The value of the alternative position is only indicative; it will not be used to calculate the offer price.

The mostimportant details of the offer can be seen in the last row of the Article List tab. The fields marked in
blue can be edited at any time.

®  Document Gross Price; the total offer priceis shown.
®* Value of Goods; the total offer price after header discounts and upcharges have been considered.

®  ECO-Contribution; this field is only visible if you have a license for the
and selected the country France with the variant with ECO-Contribution in the Project Settings.
It shows the sum of all ECO-Contribution values of the articles.

®  VAT;value defined in the Edit > Project Settings = Calculation > Taxes.
®  Final Amount; price including VAT.

®  Margin; Margin of the whole project.
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Document Gross Price: 2.252.737.20 EUR: Value of Goods: 225273720 EUR; ECO-Contribution: 5.476.20 EUR, VAT: 442.609.83 EUR: Final Amount: 2.700.823.23 EUR; Margin: 1.229.095.20 EUR (54.560 %)

Article list summary

To edit a blue shown value just click with the mouse on it. Then you will switch to the Header Claculation tab.
There you can change the values. Please also see section

In the Header Calculation window you can assign discounts and upcharges to a whole project, without editing
each and every singel article. Also this window gives you an overview of the whole projects values and
margin. The header calculation window can be activated using the Header Calculation tab.

Header Calculation
Description Percent Base Absolute
Price Date {Default Value) 21.04.20N6
Base data
Total Purchase Value 1.370,22 EUR
Sales Price Total 155627 EUR
Document Gross Price 168325 EUR
Dizcount=
Sondermrabatt 5,00 % incr. 24,162 EUR
Rabatt 2 0.00 % incr. 0.00 EUR
Additional Charges
Transport 200 % DGF 33,665 EUR
Aufschlag 2 0,00 % DGF 0,00 EUR
Totals
Value of Goods 1632752 EUR
Value Added Tax 0,00 % 0,00 EUR
Final Amount 1632752 EUR
Margin 16,079 % 262,532 EUR

Adicle List | Configurstion | Aricle Calculation | Header Calculation | Texts/User-defined Aticles | Catalog Information

Header Calculation Window

The header calculation window is made up of different columns and rows. The rows are organized in four
sections: base data, discounts, additional charges and totals. In the first row the projects is show.
This date is used for all newly inserted articles to get the price from the installed product data. You can
change the date here or you can edititin the
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8.4.1 Columns

The header calculation window has four columns, they are:
®  Description; describes a row’s values.
®  Percent; the absolute value in terms of percentage.
®  Base; the base from which the percentage value is calculated (e.g. the Sales Price or incremental)
® Absolute; the absolute value in the selected currency.

All values colored in blue can be changed by the user; pCon.basket will automatically recalculate all other
values affected by that change.

8.4.2 Base Data

This section is the starting point for the whole header calculation. It shows the sums of the different single
article values:

e Total Purchase Value; Show the sum of the purchase values of the single articles. It’s the price you pay
for the products you resell.

®  Sales Price Total; Shows the sum of the sales price of the single articles.

®  Document Gross Price; is the sum of the position net prices. This is the price you are giving to your
customer before adding header discounts or up-charges. This field can be edited, if you enter a value,
pCon will automatically calculate the correct discount or up charge and assign them to each and
every articlein the project.

8.4.3 Discounts

This section allows you to configure the discounts for the whole project. They can be entered as a percentage
or as an absolute value. The absolute value can be rounded by the system if you made the according project
settings (see and ).

The blue Discount 1 and Discount 2 fields can be renamed by selecting them with the mouse.
If you place the mouse over the Discounts row and right click, a menu will appear where you can:
® Add Discount; adds a new discount
®  Delete Discount; deletes the selected discount
®  Move Discount Up; moves the discount one position up
®  Move Discount Down; moves the discount one position down
® rel. to Sales Price Total; set the base for the percentage calculation to Sales Price Total

® rel. to Document Gross Price; set the base for the percentage calculation to Document Gross Price
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® Incremental; set the base for the percentage calculation to incremental

8.4.4 Additional Charges

This section allows you to configure the up charges for the whole project. They can be entered as a percentage
or as an absolute value. The absolute value can be rounded by the system if you made the according project
settings (see and ).

The blue Extra Charge 1 and Extra Charge 2 fields can be renamed by selecting them with the mouse.
If you place the mouse over the Extra Charges row and right click, a menu will appear where you can:
®* Add Additonal Charge; adds a new discount
® Delete Additonal Charge; deletes the selected discount
®  Move Additonal Charge Up; moves the discount one position up
®  Move Additonal Charge Down; moves the discount one position down
® rel. to Sales Price Total; set the base for the percentage calculation to Sales Price Total
® rel. to Document Gross Price; set the base for the percentage calculation to Document Gross Price

® Incremental; set the base for the percentage calculation to incremental

8.4.5 Totals

The Totals section of the Header Calculation tab allows you to view and set up the following values:

® Value of Goods;is the document gross price plus or minus eventual header discounts and header up
charges. This field can be edited, if you enter a value, pCon will automatically calculate the correct
header discount or up charge. This is useful if you want to create offers with a defined rounded total.

®  ECO-Contribution; this field is only visible if you have a license for the
and selected the country France with the variant with ECO-Contribution in the Project Settings.
It shows the sum of all ECO-Contribution values of the articles.

® VAT, the default VAT select during installation will be shown here. You can change it for each project

to do so go to Edit —* Project Settings —* Calculation —* VAT. If you have a license for the
you can also work with several VAT values in your project (e.g. standard
rate and reduced rate).

®  Final Amount;is the value of goods plus taxes. This field can be edited, if you enter a value, pCon will
automatically calculate the correct header discount or up charge. The absolute value will be rounded
if you made the according project settings (see and ).

®  Margin; the profit margin of the whole project. The margin is viewed as a percentage or an absolute
value. The margin value can be manually inserted, in this case pCon will automatically calculate the
necessary header discounts or up charges.

NOTE: If you work with the country scheme France and the variant with ECO-Contribution but there is at least
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one article in the project which does not have the required information to calculate the tax (weight and ECO-
Contribution tax category), the Final Amount fields will show ???.??. The corresponding articles are marked
as inconsistent (red font) and in the tab Configuration under the properties window a corresponding
message will be shown. For adding the required tax information to this articles

Products regularly receive new pricing while their options for configuration stay unchanged. In two
successive versions of article data, pricing information is often the only differing factor.

To deal with this, itis possible for manufacturer to provide a data version with multiple price lists. This saves
you as a user both time and hassle: You create an offer using prices from a particular date and a single
manufacturer catalog. Each of these supplied price lists come with a valid date. These price dates define the
access day for a respective price. You will use the price date to select a price list.

For example: A price list for the current year has a validity date of 1.1.2016. Enter this date in order to work
with the list for 2016. In addition, this data includes pricing for the following year. By entering 1.1.2017, you
can now work with the data for 2017.

NOTE: The specific date for the change of a price list may vary from manufacturer to manufacturer.

The pricing information is stored in the data for each individual article. You can set the pricing data for either
the complete project or, if necessary, for the individual configuration.
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8.5.1 Project Price Date
You can set the price date for a project either in the or the Header Calculation. The date
indicated here applies to all articles inserted subsequently into the project.
“e_, Project Settings @I
Address and Project Calculatlon | Texts | Cumencies

Pricing

Price Date: |21.04.2016

Currency and Tax

Country: - no specific courtry - IZ‘ Reset

Subdivison: | - no specific region -

Wariant: -~ no specific variant -

Cumency: | Euro (EUR) [+]

Tax Rates: | Value Added Tax Standard rate 00| %

Rounding

Mode: no rounding lz‘

Interval: 0.01 EUR

oK ] ’ Cancel Accept

Project price datein project settings

If you open a project that does not yet have a price date in the header calculation, pCon.basket will set
Today’s Date as the default value.

8.5.2 Article Price Date

You can view the price date for an article under the Article Calculation tab of the article view. Here you can
also change the date for an article. If you want to change the price date for several articles, please select them
and edit the price date field in the Article Calculation tab. If the selected articles have different price dates the
field shows ?2.?2.???? and you can editit.

NOTE: You can only change the price date of an article if the article is up-to-date. If your article is not yet
updated the price date will be shown in black letters and is not editable. Please the article first.

If you open an old project without a price date assigned the article Price Date will initially be shown as not
set. When with the option Saved Date, the selected items will maintain the current date. To give the
article an alternative price date, update using Date and enter your desired date. These will be determined for
the articles and their respective prices from the installed data.
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NOTE: If a price date for an articleis invalid, the article will be marked red in the article tree. In the article
view, an invalid notation will appear. Under the Configuration tab and in the Article List, an additional
indication of Invalid Price Date will be shown.

This problem is solved once you the article and select a different price date, in which a price is
available. This could be the current date, for example.
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pCon.basket enables you to easily create a printed or electronic offer with your dealership’s look and feel to
be send out to your customer.

The reports contain a series of functionalities enabling you to adapt them for the particular needs of each
proposal. For examplein a proposal you may decide not to make the individual prices visible or to show all
elements in a group summarized. You can accomplish this flexibility in a very easy and structured way.

Despite the flexibility in adapting the report to your needs the look and feel of the report is constant, allowing
all the sales reps proposals to match your dealership’s corporate image.

The print manager is the report creation engine of pCon.basket. You can activate it by selecting the command
File = Print Manager or by using the shortcut CTRL+P. A new window will open up allowing you to control the
report options.
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The first step is to select the form you’ll use as a model for the offer’s creation. You can select several forms at
once by activating the check box in front of the forms name.

-

9
g

‘;-: Print Manager =
Fams | Tests | Properties

&7 Ergodata Preview image

1[0 HwiaP

Eﬁ standard
- [ standard_21.11

q:||| -}Eu I
i
T

Description
Qffer

Werzion: 2.1.11
Date; 16.08.2012

Options Preview | Print b ail | Export ‘
Frint Manager +2 8.4 Cloze

P

Forms folder

pCon.basket comes with one default report. Depending on the manufacturers you represent you may have
access to specific manufacturer forms. These reports may provide you with a different look and feel and
extended functionality. Forms are organized as folders on the left side of the window.

When you select a form the information on the right side is updated. It shows you a preview of the report, the
version and the release date. It's important to know where to get this information in case of support needs.

To have a quick view of the selected report with the default options press the Preview button. This will open
the print preview window, which we cover in more detail in section . To return to the Print manager
window simply close the print preview window.
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NOTE: Please contact your manufacturer to get further information on which reports are available.

If the standard reports or the reports supplied by the manufacturers don’t fulfill your needs contact your

local EasternGraphics team for further information.

In this section you can enter the initial and end text for your proposals.

":-: Print Manager

| Formsl Tentz |Pr0perties

I?I@

the event of the client supplying drawings,

Front text

End text

Maotes:

1. Each wooden veneer colour has itz own shades and grain that can be slightly different from the sample
baard depending an their argin and/on the autput. LY light may make all wood finizhes become darker

upoh ugage for & certain period. =
2. This quotation iz open for acceptance in writing within thirty days of submission. Otherwise, the quatation

iz subject ta revisian.

3. This tender iz conditional upan the client having supplied uz with lay-out drawings and any information
regarding construction details and site conditions necessary for us to have made a reasonable estimate of

the cost of the supply of goods and of the works required and the time needed for the completion thereof. In

Optioks Freview | Frint |

Frint Manager v2.8.2

Texts window

You can write the text directly on the available spaces or you can load the text from a .txt file. To load a text
press the ‘..." button on the right side and identify the text file you would like to load.

If your dealership has more than one user, it's recommended that you use the loading of the text files method.
You can have on a centralized location the needed text files so that you can easily update them.

If you close the current file and open a new one you’ll find the latest inserted

text still there. This is due to the

fact that these types of texts are quite static, like for example terms and conditions, meaning that you don’t

have to be always writing or loading them.

NOTE: The availability of the Texts tab in the Print Manager may depend on the type of pCon.basket license
you own. If you also have the Organizer in use, this tab can be found in the Organizer Project Settings.
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9.3 Properties

This section will be visible only for certain reports. It provides the user with the chance to define particular
properties for the selected report.

-

‘e“ Print Manager I?‘@

Report language: Ide - Germah LI zet as default | Feset default: |

= Layout &
Company laga W Or
Show footer W On
Firm address W O
shant firm address Off
Logo |:|
Footer |:|
Title
Adjustrment [address) lirkz
Start listing articles on 2nd page Qff
Dizcount in percent v On

Bl Article list -
Show manufacturer # productline I+ Or
Price Components I Qrf
Pasition net price I Off

Options | Freview I Frint b il | Export |
Frint M anager +2.8.5 Close |

Properties window

Typical examples include the option to enable/disable the company logo or the option to have a cover sheet.

HAWORTH

OFFERS OFFERS
Page 1 Page 1
ste:  Srns Date: V142008

e — e Customer number: Order mamber:

Logo turned on Logo turned off
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You can set up several properties for all of the available forms. By selecting the Options button a new window

will open up.

‘;-: Options £3
Optiong |
Report folder
Falder C:Program Files [86]4E astermGraphicspCon. basket\ pluging' prin J
Test ophons Other options
[ Use default text [v Show single prices
[ Usze short text [ Show sum prices
[v Show sub tatals
v Use long text
B Le=long e [v Show pozition dizcounts

v Usze vanant test
v Use addon text

Article number:

" Default

v Base article number
" Final article number

" Hide article number

Show images
Frint duplicated articles only once
Frint only selected articles

7=

Fieport options

[v Shaow export options
[v Save Settings to projectfile

st ag default

Ok | Cancel

ReportManager Options

This window is organized in different sections. Each one of these sections enables you to define how to
present these fields in the report.

To check the changes click on the Ok button and in the main print manager window activate the preview.

9.4.1 Text options

In this section, you can choose which type of text to enter under article description. You can have none or
several text options selected. Choose between the following entries:

®  Default text; displays the default description text

®  Short text; displays the short text description

® |long text; displays the long text description

® \Variant text, displays the article’s properties which can be configured. This is a dynamic field since it

is automatically updated when the user changes the products properties

e Addon text; displays the additional text when it is entered under the User Text/Article tab in the work

space. If you don’t want to display the manufacturer’s standard commercial description you can turn

all the other texts off and have only this field visible

The contents of each of these fields, with the exception to the addon text, depend on each manufacturer
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commercial description. For example, one manufacturer can have the article code available in the standard
text while other may not.

Description Amount Description Amount Description Amount
1 1 1
Frofessional chair with ammrests Surface's colour 12/0008 THIS IS AN ADDITIONAL TEXT
parmanent contact plastic base Wheel's kindisliding: Castors for hard floors
S ysaobaaa (32 Structure's colour: Chromed
Fixed code: ILC10RGCADS
= \ . '_ﬁ‘ . —y
Default text Variant text Addon text

9.4.2 Article number

In this section, you can choose which article code you want to make visible. You have the following options:

®  Default;in most cases the default article number is the basic article number

®  Base article number; displays the basic article number, which usually represents the model base
number

®  Final article number; displays the complete article number, which is normally the model base number
plus all the remaining configuration options translated into the article number.

®  Hide article number; no article number will be visible in the offer

Pos Description Amount Pos Description Amount
1 H10 1 1 H10118 1
Basic article number Complete article number

9.4.3 Other options

In this section, you can select how to display the article’s prices and images. You have the following options:
® Show single prices, displays an article’s unit price, which is the price of each single article

® Show sum prices, displays an article’s total price, which is the price of each single article multiplied by
the quantity

® Show sub totals, displays a folders’s partial total. You have to activate the ‘show subtotal’ option in
basket’s main window. See section for further details.

® Show position discounts, displays the discounts/up charges applied to the articles
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Pos Description Amount Unit price Total
1 Meeting Room singls prices @
14 Standard - Office elements 1 894 20 EUR 894,20 EUR
GOIEXTA
Tabike, conflg.. siideatile iop, helght adjustabie
1 | Discount 1 {15,00 %) -134.13 EUR
| ]
: Fogition discounts
1.2 Standard - Office elements 1 1.105,30 EUR 1.105,30 EUR
GOIEXTAS
Cormer bk
]
Sub total: Meeting Room 1.865,87 EUR

You also have these extra two options available:

® Show images, displays an article’s image in a pre-defined location. The image accurately represents
the object with all of the configurations performed by the user. For further information on how to
change the standard image display see section

® Print duplicated articles only once, displays a repeated article image and description only once. For
duplicates only the article code and the original position reference will be visible. Duplicate articles
are articles with the same article code and configuration options.

Pos Description Amount Unit price Total
1 L661218 1 EUR294.00 EUR294.00
2 L661218 1 EUR294.00 EUR294.00

ref. position 1

Position 2 represented as a duplicate article

® Print only selected articles, only articles selected in the article list will be shown.

9.4.4 Report options

In this section, you can define the report language and the pdf export options:

® Report language, changes the report standard text to the available languages. See section on
how to change the catalog languages so that you can display the commercial description in any of
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your manufacturer’s available languages.

® Show export options, by enabling this option you’ll be presented a series of options before pCon.basket
creates the offer pdf file. See section for further information.

® Save Settings to project file, by enabling this options all the settings you made will be saved in the
project file (obk). If you share a project file with a colleague he will have the same settings for report
as you have made and therefore see exactly how your report looked like.

There are properties which influence the printed offer and that are defined in the main pCon.basket window
instead of the print manager window. This is due to the fact that all properties configured in the print
manager window are valid for the entire offer, the following properties can be defined for a specific selection
of articles and groups.

The article/group settings section is available under the tree section. Its properties change depending if the
user selects an article(s) or a group(s).

9.5.1 Article settings

To visualize the article settings select at least one article, you can select several articles and apply the print
settings to all of them with one command.

Page break bafors position
Adicle Image Position default

Anicle Image Width 5.00 em
Adicle Image Alignment left

Article format property section

The following print settings are available:

® Page break, enables to set a page break before or after the selected position. Page breaks are usually
defined as the last property setting.

® Article image position, enables to determine the vertical alignment — centered, above or below the text.
® Article image width, determines the size of the image in the printed offer. The default sizeis 5cm.

® Article image alignment, enable to determine the horizontal alignment — left, left to text, centered or
right.
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9.5.2 Group settings

To visualize the groups settings select at least one group, you can select several groups and apply the print
settings to all of them with one command.

Show Subtotal no
Page break none
Folder Image Width 5.00 cm
Folder Image Alignment left
Group sub posiions no

Group format property section

The following print settings are available:

Show subtotal, enables the group(s) subtotal to be visible in the report. The subtotal will be visible at
the end of the group and will display ‘Sub total: [Group Name]’.

Page break, enables to set a page brake before or after the selected position. Page breaks are usually
defined as the last property setting.

Folder image width, determines the size of the image in the printed offer. The default sizeis 5cm.

Folder image alignment, enable to determine the horizontal alignment — left, left to text, centered or
right.

Group sub positions, enables to hide all articles belonging to the selected group(s). This is particularly
useful when you have products which are made up of many articles. A common example is a partition
wall, the client doesn’t care the price or even the wall sub articles, it just cares how much each wall
segment costs and its characteristics. As an alternative you can also use Set Articles instead of a folder
with this option (see section ).

Description Amount Unit price Total Pos Description Amount Unit price Total

Reception EURS, 147.00 1 Reception EURS,147.00
i ana maple s ™ 15 370 Mapke TpE.

Width of 9cm Width of 4cm

Center alignment Left alignment
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9.6 Preview

To see a preview of your offer press the ‘Preview’ button, a new window open up on top of pCon.basket.

Hlal®Tsals «[7 =4

Aot cose | Besoripian untly
Lestzi 1
Lee

gz
IPs

v
]

TEAME ANG EOHDITICHS.
1 carsrs

Page te12 |

Print preview window

On the top section of the screen you have several options:
® Print report, opens up the prints dialog box

® Export report, enables you to export the current report into several formats — pdf, xIs, htm, rft, emf, wmf,
jpg and bmp. The most used export type is the pdf format, for further information on how to use
advanced export option see section Save as pdf.

® Fit height, automatic zoom where the page height occupies the entire preview window
® Actual size, automatic zoom where the page is shown with its real physical dimensions
® Fjt width, automatic zoom where the page width occupies the entire preview window

e Zoom in/Zoom out, enables you to zoom in and out of the page. The zooming can be done step by step or
by setting the desired zooming percentage

® Page navigation, enables you to jump to the first page, go to the previous page, go to the next page or
jump to the last page
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9.6.1 Save as pdf

When saving a report as a pdf you can have great control over how your pdf file is created. To ensure that
these extra options are available you have to select ‘show export option’ from the options dialog window, see
section

You’ll be asked to define the offer’s file name, after selecting OK a new window will show up. In this window
you can define several extra options. Following we’ll highlight the most important ones:

® Optimize Image Export, Images are compressed before exported.

® Use JPEG Compression, by activating this option the whole file is compressed. You achieve a smaller file
size but compression artifacts appear.

® Compression Level, according to the compression level the file size can be reduced. With high
compression rate the image artifacts get worse.
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For further information on how to import an article list of project started in pCon.planner or pCon.xcad see
section

By selecting File & Import you have the possibility to import an OBX file. OBX is the OFML Basket Exchange
format. Previously exported pCon.basket items can be imported into a project. That way the exchange and re-
use of position data will be simplified drastically.

pCon.basket allows you to save offers under different formats. By selecting File = Export, the following
options appear:

® Export Default

This command allows you to export the offer to the format selected under Tools = Preferences = Exports
- Export Default. In fact, by selecting a format among those offered with this command, it will become a
type of export that you will use frequently.

* CSV
Create a .csv file, which you can open in Excel and that allows you to enter the offer created with

pCon.basket in an .XLS document.

* RTF
Create a .rtf file, which you can open in Word and that allows you to enter the offer created with

pCon.basketin an .DOC document.

® GARB2IO
Create a compatible file with software for interior design, very common in Germany.

* 0OBX
Selected articles of an open pCon.basket project can be exported in the native format of the Basket
(OBX — OFML Basket Exchange). Either the articles can be stored in a file or passed to an external
application. Vice versa, previously exported Basket items can be imported into a project.

A PDF exportis possible by using the Print Manager (see ).

NOTE: The availability of the different Imports and Exports may depend on the type of pCon.basket license
you own.
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With the pCon.basket update concept you have the possibility to update old projects to the latest installed
product data. For example a customer wants to order a workstation once again he has ordered one year ago.
In between this year the prices have changed. Also some of the articles don’t exist anymore and for some
articles the configuration is not supported anymore. The Update function of pCon.basket will help you to find
all those articles and to migrate them to the latest product data.

Positiol

1.1

Article List Corr
There are different updates states an article can have:

e Unknown: displayed by the following icon ?

The system has not yet checked whether this article is supported by the current installed data. After
opening a project all articles will have this state.

® Updateable: displayed by the followingicon e

The article and its current configuration are supported, but prices and texts are not yet updated. This
state is assigned if you watch the configuration of an article in the configuration tab without
changing any property.

®  Up-to-date: displayed by the following icon v

The article and its current configuration are supported. Prices and texts are updated.

®*  Migrate-able: displayed by the following icon 7

The articleis availablein the currentinstalled product data but the configuration is not supported.

®  Migrated: displayed by the following icon @

The article is available in the current installed product data but the configuration was not
supported. The system has made an automatic migration to the latest data version and reproduces
the configuration as far as possible.

® |nvalid: displayed by the following icon !
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The article does not existin the currentinstalled product data.

There are two ways to update articles

1. Selectthearticle and go to Extras = Update Basket Articles. A dialog will then be displayed. Within
this dialog you can decide for the selected article whether
® to usethe

already saved within the project (Saved Date)

® to assign the article the current date as the (Today’s Date)

® to enter a new date (Date).

In addition, here you can choose whether or not to adjust the price date of a project (Update project
price date). This option if available for Today’s Date as well as a manually-entered Date. If this option is
enabled, the will be adjusted for all selected articles during the update process, and the date
for all articles will be adopted by all subsequent articles that you insertinto the project. If this option

is disabled, the entered date will be updated for all selected articles. Articles that are later inserted will
maintain the saved date thatis set on a planning level.

*r‘: Update Basket Articles @

Price date to use for update

Saved date

Update header price date

0K ]| Cancel

Article update with price date

After pressin Ok all selected articles are checked. If they exist and their configuration is supported prices
and texts are updated.

2. Select the article and go to the Configuration tab.

If the article exists and the current configuration is supported, the properties of the article are
shown. If you don’t change any property the price and text will not be updated (state: updateable). As
soon as you change any property price and text will be updated (state: up-to-date).

If you want to update the whole project at once select all articles (Ctrl + A) and call Extras > Update Basket
Articles.

NOTE: If you do not want to work with , always select Today’s Date during the update. The

article will then keep its current price. This corresponds to the update process of earlier version of
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pCon.basket.

In this case, please update your project every time you open it. In addition, you have to check Update project

price date in order to change the project price date to the current date. This done, articles will be inserted
using today’s date.

NOTE: If you open a project that does not yet have a the article Price Date will initially be shown
as not set. When updating with the option Saved Date, the selected items will maintain the current date.

Articles with the state migrate-able exist in the currentinstalled product data but their configuration is not
supported anymore (e.g. because there is one property missing in the new data or a specific finish color was
discontinued). Those articles can be migrated to the latest data automatically:

1. Selectall articles you wish to migrate.

N

In the pCon.basket menu go to Extras = Migrate Basket Articles. A dialog will then be displayed.

Within this dialog you can decide for the selected article whether

to use the already saved within the project (Saved Date)

to assign the article the current date as the (Today’s Date)

® to enter a new date (Date).

In addition, here you can choose whether or not to adjust the price date of a project (Update project
price date). This option if available for Today’s Date as well as a manually-entered Date. If this option is
enabled, the will be adjusted for all selected articles during the update process, and the date
for all articles will be adopted by all subsequent articles that you insertinto the project. If this option
is disabled, the entered date will be updated for all selected articles. Articles that are later inserted will
maintain the saved date thatis set on a planning level.

All articles migrated by the system get the symbol @ in thearticlelist.
3. You can now check the automatic migration of an article. In the article tree make a right mouse

button click over the article and select Article Features...
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A new window opens where you see the current (middle column) and old (right column) configuration
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"e_: Article Features

1. PLSONDER

Base article number:
w./d/h in mm:
assignment:
PLFREIFORM:

work surface materal:

boand thickness:
top colour:

edge colour:

width {mm);

depth imm):

cutouts (AAB/KDE):
ZEICHNR:

Logo:

packing:
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single board
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standard top

25

as top
1000
1000
no

ASSMANN
Standard

Next Migrated ] ’Accep‘t Migration

FLSONDER

1 F 10
(Ll (Ll

Pa
en

single board

no

standard top

25

maple melamine {AD)
as top

A4
(LD

1
(Ll

no

ASSMANN
Standard

Article Features window

To change the current configuration go to the tab Configuration of pCon.basket. The Article Features

window will stay opened.

After completing your changes to the configuration click the Accept Migration button. The system will

now delete the original configuration and show only the current configuration in the Article Features

window.

Using the button Next Migrated you can jump directly to the next automatic migrated article in the

article list to check his configuration.
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During the automatic migration through the system all calculation information (quantity, discounts,
surcharges, etc.) is maintained.
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pCon.basket allows the integration of the commercial information contained in the offer into other systems.
The integration can be done with a dealer’s internal system or with the manufacturer’s order entry
application.

The integration of the offer information contained in pCon.basket can be done with two perspectives, both of
which bring important benefits to your dealership.

For further information on how to integrate pCon.basket’s contact your local EasternGraphics team. We'll
provide you with all the necessary information.

12.1.1 Commercial analysis

To correctly manage your sales it’s very important to have the possibility to have real time information on the
offers being created by the sales team. For example, at the end of each day, in an automatic way and without
extra work from the sales reps, it would be important to have information like:

® What's the total value of the proposals send out?
® What was the percentage for each type of product series?
e What was the percentage by ZIP code?

With this type of information available real-time your business can be managed from a reactive to a more
proactive way. You don’t have to wait for the end of the sales process to identify potential problems in your
sales pipeline.
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12.1.2 Order processing

If an offer becomes an order you can extract the commercial data contained in it and integrate it in your
dealership internal management system. This way you don’t have to manually type the offers which become
orders again in your internal system.

Report1
e —
Extraction
ok [ =p | Queries | = | Report2
into DB Offers DB
or CRM —
—
Extraction Int | —
nterna
OBK |::> . Internal
o application application Transport
application PP document
DB e —

Scheme of order integration process

Many manufacturers have created an integration process from pCon.basket into their internal order entry
systems. This integration represents an important reduction on manual work, decreased error reduction,
increased savings and efficiency for both dealerships and manufacturers.

The specific process of sending an order depends from manufacturer to manufacturer. But it usually involves
uploading an file through a web page. Once received the manufacturer integrates it into their internal ERP
(Enterprise Resource Planning) application for processing.

Please contact the manufacturer’s you represent for further information on their order entry process.
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Itis possibleto personalize pCon.basket. The Extra = Preferences command opens a dialogue window divided

into categories which contain various options organized by subject.

In the Common category, you can configure preferences under the following entries:
® languages; allows you select the preferred language for the data and catalogues.

® Units; allows you to select the unit of measure for lengths in meters, centimeters, etc, decimal numbers,
the unit of measures for angles and their precision.

® Save; configure the time interval between automatic saves of the offer.
® Retailer Information; allows you to enter personal data about the user.

® Catalog; allows you to configure the viewing methods for articles in the catalog and choose the font
and size of the descriptions.

® Property Editor; allows you to choose whether to view the article properties (color and finish) by name,
code (key only) or both (key and text).
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Category

- Common

- Languages

- Units

- Save

-~ Retailer Infarmation
- Catalog

-~ Property Editor

—|- Bashet

- Common Options
- Bashet View

- Prices

- Cumencies and Taxes
- Preview Image

- Print

- Graphical settings
i 30 Preview Settings
- Exports

=J-- Send mail
“e Commion

Categories of pCon.basket settings

In the Basket category, you can configure preferences under the following entries:

® Common Options; allows you to choose if you want to be asked for confirmation each time you delete
an article. Furthermore you can define when the system should check the articles for consistency, so
whether the articles are fully configured and valid. Also you can set what information should be shown
in the article tree for each article, in what order they should be shown and what sign should be used
for separating the information.

Article Tree Label

[w Manufacturer Up Delimiter: |/
[+ Seres
[+ Base Aticle Number w

[+ Description

Settings of article tree label

® Basket View; allows you to select the default application basket view for new projects. For information
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on how to define a project view see section and . If you want to create
a new project view or want to change a project view the way of working is the same as shown under

. and . Furthermore you can define which views should be added to
already existing projects if they don't exist there. This could be the case for example if you get a project
from a colleague or a project which has been created with pCon.xcad.

® Prices; you can set percentages of purchase or sales prices in this dialogue window. These percentages
refer to the series and will be used every time an article of this series is inserted. If you want to define
the percentages on manufacturer level please deselect the option Series-specific Configuration of
Purchase Value and Sales Price.

® Currencies and Taxes; allows you to set default country, currency, rounding mode for prices and VAT,
which will be used when new projects are created. Also you can change the exchange rates for new
projects here. With the button Reset in the tab Exchange Rates you can reset all exchange rates to the
rates pCon.basket brings with him during installation. If you want to change the country, currency,
rounding mode, VAT or exchange rates for an existing project go to the Project Settings (see
). If you want to apply the rounding settings to all existing projects when opening, activate
the option Apply rounding to existing projects. For more details on the possible tax settings read the
chapter

® Preview Image; offers a summary of the values that control the image print preview.

13.2.1 Aside note to rounding

With pCon.basketitis possible to round article prices to full Euro/USD after a discount has been subtracted.
The kind of rounding can be setindividually.

The following rounding modes are available:
® No Rounding: pCon.basket will calculate in the same way as you are used to it.

® Half away from zero: With this rounding mode the system will round towards the nearest neighbor
unless both neighbors are equidistant, in which case the system will round up (away from zero). For
example:

® 45->50
® 55>6.0

® Half towards zero: This rounding mode also rounds towards the nearest neighbor unless both
neighbors are equidistant. In that case the system will round down (towards zero). For example:

® 45540
e 55->50

® Half to even: The system will also round toward the nearest neighbor. In case of equidistant neighbors
the system will round towards the even neighbor. This rounding mode is also called Banker’s
Rounding. For example:

® 45540

® 55560
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For every rounding mode additionally the interval can be defined:
® 0.01: The system will round to full cent. This is the same behavior as in previous pCon.basket versions.
® 0.05: The system will round always to full 5 cents. For example:
® 456 > 4.55

® 24524 - 245.25

0.10: In that case it will be rounded to full 10 cents. For example:
® 456 2> 4.60

® 24524 - 245.20

0.25: This interval means that the priceis always calculated to full 25 cent. For example:
e 456 > 4.50

® 24524 - 245.25

0.50: The system will round to full 50 cents:
® 456 > 4.50

® 24524 - 245.00

1.00: It will be rounded to full Euro/USD.
® 456 > 5.00

® 245.24 - 245.00

Since by rounding prices always an error occurs, pCon.basket only rounds the Total Position Net Price for
single articles and in the header calculation only the Discounts and Additional Charges as well as the Final
Amount. The VAT is not rounded.

In the Print category, you can configure preferences under the following entries:
® Settings; opens the window that allows you to set the print parameters.

® Dealer Address; allows you to enter the wholesaler's address that will be used for the print job.

NOTE: The availability of the Print settings depends on whether there is a Organizer used or not. If the
Organizer is used those settings will not be available.
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® 3D Preview Setup; allows you to set up the article's image view. E.g. you can set whether you want to

have all article images with Textures and use the Realistic representation which is the best preview but
makes high demands on the graphics hardware.

3D Preview Settings
Rendering settings
@ Textures ) Grey scale

() Color () Black / White
Realigtic representation

Environment

Brightness: D

COutline edges
[7] Outline edges

Line width: |1 :

Setting of articleimage preview

® Seesection

® General; allows you to enter general data for sending exports by email.
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With the additional module Taxation Schemes in pCon.basket you can define country and region specific tax
rates. The function supports you for example when preparing an offer in France with showing the ECO-
Contribution (according to the Valdelia specification) or creating an offer with several VAT rates (e.g.
standard rate and reduced rate).

For activating the module you need an additional license for pCon.basket. If you are interested in this license
please contact your local distribution partner.

NOTE: Please note that pCon.basket only supports the calculation of the French ECO-Contribution according
to the office furniture scheme, which was defined by Valdelia. The calculation according to the home
furniture scheme defined by Eco-mobilier is not supported.

In the menu bar select Edit = Project Settings ... In the new window go to the tab Calculation. Under the
category Currency and Tax select the country you want to do your offer for. The taxation scheme of this country
will be used for the tax calculation. If you select a country which also differentiates its tax calculation by
regions (e.g. USA), the property Subdivision is enabled and you can select the desired region (e.g. Texas).

In some countries there can be several variants of taxation schemes. For example the calculation of the ECO-
Contribution in France is only necessary for the furniture market. If you want to do an offer for products
which are not liable for the ECO-Contribution, select the default variant. It only calculates the VAT for France.
In case you want to show the ECO-Contribution on your quote select the variant with ECO-Contribution.

*i; Project Settings |?|

Address and Project Cumrencies

Currency and Tax

Country: France |z| Fesst

Subdivison: | - no specfic region -

Variant: with ECO-Contribution |Z|

Cumrency: Euro (ELR

Tax Rates: | Value Added Tax Iz‘ standard_rate |z| 156
Raounding

Mode: | half away from zero |z|

Interval: | 0,01 EUR [=]

Project Settings with taxation scheme France

You can only select a currency if the tax scheme variantis not depending on a fixed currency. For example the
display of the ECO-Contribution is fixed to Euro, since the tax rates are defined in Euro.

For checking or changing the tax rates you first have to select the tax type (e.g. ECO-Contribution). In the
second selection list you now see the available tax categories. Select the category you want to change the tax
rate for. It will be displayed in the last field. You can now edit this value.
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Cumency and Tax
Courtry: France E
Subdivison: | - no specific region -
Variart: with ECO-Contribution E
Cumency: Euro (EUR)
Tax Rates: | ECO-Cortribution [=] | Seat metal) [+]
Seat [metal) -
Rounding Seat (wood)
Mode: | no rounding E‘ Seat plastics) |
—— Seat (other material) =
Interval: | 0,01 ELUR StDlEgE |:ITIETE|}
Storage (wood)
Storage (plastics)
Storage (other material)
Workplace (metal)
Workplace (wood) -

EasternGraphics

Feset

0.096 | EUR/KGM

Selection of the tax category for France

If you want to reset the tax rates of your currently opened project to the globally defined tax rates click the

button Reset.

All settings mentioned above can also be done globally, so they will be preset for every new project. To do this
go to Extras = Settings in the menu bar. In the category tree open the Basket entry and select Currencies and
Taxes. With the button Reset in this dialogue you reset the tax rates to the values available in the pCon.basket

installation.

The tax will be calculated automatically by pCon.basket according to the selected tax scheme. For this
pCon.basket reads the tax category for every inserted article from the OFML data and uses the according tax
rate. In case of the French ECO-Contribution pCon.basket also reads the net weight of the article from the

OFML data to multiply it with the tax rate. The result of the calculation is shown in the tab Article Calculation.

The tab Header Calculation shows the total of the calculated taxes.
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Article Calculation

Description Percent Base Absolute Count Total

Base data
Purchase Gross Price 300,00 EUR 1.500,00 EUR
Wendor Discount 0,00 % iner. 0,00 EUR 0,00 EUR
Purchase Value 300,00 EUR 1.500,00 EUR
Sales Price 300,00 EUR 5.00x 1.500,00 EUR

Dizcounts and additional charges

(7] Rabatt 1 0,00 % iner. 0,00 EUR 0,00 EUR
[?] Rabatt 2 0,00 % iner. 0,00 EUR 0,00 EUR

Position Met Price 300,00 EUR 1.500,00 EUR

Header discounts and additional charges
Rabatt 1 0,00 % incr. 0.00 EUR 0,00 EUR
Rabatt 2 0.00% iner. 0.00 EUR 0,00 EUR
Aufschlag 1 0.00 % PMF 0.00 EUR 0.00 EUR
Aufschlag 2 0,00 % PMF 0.00 EUR 0,00 EUR

Totals
Net Total 300,00 EUR 1.500,00 EUR
ECO-Contribution 1452 EUR 7460 EUR
Walue Added Tax 1960 % 61,724 EUR 308,622 EUR
Gross Total 376,644 EUR 1883222 EUR
Margin 0,00 % 0,00 EUR 0,00 EUR

Adticle List Corfiguration | Article Calculation | Header Calculation | Texts/User-defined Articles Catalog Information

Article Calculation for an article liable for ECO-Contribution

The ECO-Contribution can only be calculated for an article if all relevant information (tax category and net-
weight) is maintained in the OFML data. If the information is not available, the tax is not shown and in the
field Gross Total the value ??2,?? EUR is shown. If you want to add the information for the ECO-Contribution
calculation manually convert the article into a user-defined article.

Totals

Met Total

Gross Total

Margin

0,00 %

1.353 60 EUR

0.00 EUR

135360 EUR
1P EUR

0.00 EUR

The information for calculating the ECO-Contribution is not available in the OFML data
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15 SYSTEM REQUIREMENTS

Export Formats:
® CSV, RTF, OBX, GARB2I0O
Supported Data Formats:

e OFML
Languages:

® English
® German
® French
® |talian
® Spanish
® Dutch

The latest system requirements are available on our website.
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We work hard to increase the quality of our products. Nevertheless, during the use of our software,
problems or questions may arise. In such cases please contact our Support department.

E-mail:

Phone: +49-(0)3677-678233

You may contact us

Mon —Thu 9:00-17:00 C.E.T.

Fri 9:00 —14:00 C.E.T.

Please include the following information always into your support request:
e the version of your product,
® a detailed description of the problem or error,
® in case of error, the specific workflow that caused this error,
® the error message as such and

¢ infortmaion about your system environment

Additionally, we look forward your hints and wishes concerning our products and service.

Further information around our Service can be found on our web-site
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Legal remarks

© 2015 EasternGraphics GmbH | Albert-Einstein-StraBe 1 | 98693 lImenau | DEUTSCHLAND

This work (whether as text, file, book or in other form) is copyright. All rights are reserved by EasternGraphics
GmbH.

Translation, reproduction or distribution of the whole or parts thereof is permitted only with the prior
agreement in writing of EasternGraphics GmbH.

EasternGraphics GmbH accepts no liability for the completeness, freedom from errors, topicality or continuity
of this work or for its suitability to the intended purposes of the user. All liability exceptin the case of
malicious intent, gross negligence or harmto life and limb is excluded.

All names or descriptions contained in this work may be the trademarks of the relevant copyright owner and

as such legally protected. The fact that such trademarks appear in this work entitles no-one to assume that
they are for the free use of all and sundry.
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